
 

Title page

CGM MEDISOFT User’s Guide

December 2022



CGM MEDISOFT 27
ii December 2022

Copyright notice  

Copyright notice
Copyright © 2022 eMDs, a brand of CompuGroup Medical. All Rights Reserved. 

Use of this documentation and related software is governed by a license 
agreement and this document is incorporated into and is made part of the 
license agreement. This documentation and related software contain 
confidential, proprietary, and trade secret information of eMDs, a brand of 
CompuGroup Medical, and is protected under United States and international 
copyright and other intellectual property laws. Use, disclosure, reproduction, 
modification, distribution, or storage in a retrieval system in any form or by any 
means is prohibited without the prior express written permission of eMDs, a brand 
of CompuGroup Medical This documentation and related software is subject to 
change without notice.

Publication date
December 2022

Product
CGM MEDISOFT 27

Corporate address
eMDs, Inc.
10901 Stonelake Blvd.
Austin, Texas 78759
512-257-5200



CGM MEDISOFT 27
December 2022 27 iii

 Table of Contents

Table of Contents

Preface . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . ix
Where to Find Help . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  ix

Online Help  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  ix
Training  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  ix
Independent Value-Added Resellers . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  ix

CGM MEDISOFT Versions . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  ix

Chapter 1 - Navigating in CGM MEDISOFT . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 1
Toolbars. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1

Title Bar. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1
Menu Bar  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1
Toolbar  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1
Shortcut Bar  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  3

Menus . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  3
File Menu  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  4
Edit Menu  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  4
Activities Menu  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  5
Lists Menu. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  6
Reports Menu . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  7
Tools Menu . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  8
Window Menu . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  8
Help Menu. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  9

Keystrokes and Shortcuts . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  9
Common Keystrokes. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  10
Keystrokes - List screens  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  10
Keystrokes - Transaction Entry . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  11
Keystrokes - Eligibility  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  11

Chapter 2 - CGM MEDISOFT at a Glance . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 13
Setting up Your Practice Overview . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  14
Entering Transactions and Payments . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  19
Generating Claims and Statements. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  19

Chapter 3 - Creating a Practice and Setup Overview . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 21
Creating a Practice  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  21

Creating the Practice Database  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  21
Opening a Practice . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  22

Setup Overview . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  22
Creating Rules Overview  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  23
If you are a solo provider (file claims as an individual) . . . . . . . . . . . . . . . . . . . . .  24
If you are a group (file claims as a group). . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  26

Setting Program Options . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  28

Chapter 4 - Security Setup Overview. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 31
Users upgrading . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  31



CGM MEDISOFT 27
iv 27 December 2022

 Table of Contents

Creating Users. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  31
Login/Password Management . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  32
Setting Permissions. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  33

Chapter 5 - Entering Practice Information. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 35
Entering Basic Practice Information  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  35
Entering a Practice IDs Rule . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  35
Entering Practice Information for a Billing Service. . . . . . . . . . . . . . . . . . . . . . . . . . . .  36

Billing Services . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  36
BillFlash Users  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  37

EDI Receiver Records . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  38

Chapter 6 - Setting up Providers and Provider Classes  . . . . . . . . . . . . . . . . . . . . . . . . . . 41
Entering Provider Information . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  41

Entering Provider IDs Rules . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  43

Chapter 7 - Referring Provider Records  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 45
Entering Referring Provider Information  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  45
Entering Referring Provider Rules . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  46

Chapter 8 - Insurance Classes and Insurance Carriers . . . . . . . . . . . . . . . . . . . . . . . . . . . 49
Insurance Classes . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  49
Insurance Carriers . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  50

Chapter 9 - Facility Information  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 53
Setup Scenarios . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  53
Entering Facility Information  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  53
Entering Facility IDs Rules  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  53

Chapter 10 - Attorney, Employer, or Other Addresses . . . . . . . . . . . . . . . . . . . . . . . . . . . 55

Chapter 11 - Procedure, Payment, Adjustment, and Diagnosis Codes  . . . . . . . . . . . . . . 57
Procedure, Payment, and Adjustment Codes . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  57

General Tab  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  58
Amounts Tab. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  58
Allowed Amounts Tab (Advanced and CGM MEDISOFT Network Professional) .  59

MultiLink Codes . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  59
CPT Code Search . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  59

New CPT Code Search screen (single code search) . . . . . . . . . . . . . . . . . . . . . .  60
New CPT Code Search screen (multiple code search). . . . . . . . . . . . . . . . . . . . .  61

Chapter 12 - Diagnosis Codes  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 65
IMO - Enhanced ICD Search  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  66

Chapter 13 - Billing Code List. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 75

Chapter 14 - Contact List . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 77

Chapter 15 - Patients . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 79
Chart Number Considerations . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  79



CGM MEDISOFT 27
December 2022 27 v

 Table of Contents

Entering Patient Information  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  80
Patient Alerts. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  80

Chapter 16 - Cases. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 87
Creating a Case. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  87
Copying a Case . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  89
Customizing the Case screen . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  90

Scanning . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  90

Chapter 17 - Transaction Entry Alerts . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 97
Transaction Entry Alerts screen  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  101
Transaction Entry Alert pop-up . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  104

Chapter 18 - Entering Transactions . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 107
Unprocessed Transactions . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  108

Chapter 19 - Quick Ledger and Quick Balance . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 109
Quick Ledger . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  109
Quick Balance  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  110

Chapter 20 - Creating Claims . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 113
Claim Management . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  113

The Claim Manager’s Job  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  113
Creating Claims. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  114
Editing Claims . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  114
Printing Claims  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  115

Troubleshooting Insurance Claims  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  117
Claim Form Not Centered . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  117
Reprinting Claims . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  119
Changing Claim Status . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  119

Chapter 21 - Creating Statements  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 121
Statement Management . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  121

Creating Statements . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  121
Editing Statements  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  122
Printing Statements. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  122
Reprinting Statements. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  125
Changing Statement Status  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  125
Billing Cycles. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  126

Troubleshooting Statement Printing  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  127

Chapter 22 - Applying Deposits/Payments . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 129
Entering a Payment . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  129

Applying a Payment  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  129
EOB Payments  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  130
Managed Care. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  130

Capitation Payment. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  131
ePayments. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  131



CGM MEDISOFT 27
vi 27 December 2022

 Table of Contents

Chapter 23 - AR Tracker  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 133

Chapter 24 - Managing Small Balance Write-Offs. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 143
 Small Balance Write-off . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  143

Chapter 25 - Using Electronic Services . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 145
Electronic Claims Processing  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  145
Statement Processing . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  145
Eligibility Verification . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  145

Eligibility Verification Setup . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  145
Eligibility Verification Results  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  146

Chapter 26 - Scheduling Appointments. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 149
Office Hours Overview. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  149
Starting the Program . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  149
Office Hours Setup  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  149
Using Office Hours  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  150
Entering a New Appointment . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  150

Find Open Time  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  150
Go To Date . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  151
Wait List  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  151

Editing an Appointment . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  152
Changing a Telephone Number or Cell Phone . . . . . . . . . . . . . . . . . . . . . . . . . .  152
Changing Other Information . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  152

Viewing Scheduled Appointments . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  152
Viewing Future Appointments . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  153

Using the Future Appointment List screen  . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  154
Using the Edit Appointment screen. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  154

Rescheduling an Appointment. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  155
Moving/Deleting an Appointment. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  156

Moving an Appointment  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  156
Deleting an Appointment. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  157

Recalling Patients  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  157
Setting Program Options . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  158

Options tab . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  158
Multi Views tab  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  159
Appointment Display tab . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  160

Chapter 27 - Reports . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 163
Reports Overview  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  163
Report Procedures  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  163

Viewing a Report. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  163
Printing a Report . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  163
Exporting a Report . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  164
Searching for a Specific Detail in a Report . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  164

Available Reports  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  164
Day Sheets . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  164
Analysis Reports . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  166
Aging Reports  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  169
Production Reports  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  169
Activity Reports  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  170



CGM MEDISOFT 27
December 2022 27 vii

 Table of Contents

Collection Reports  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  170
Audit Reports  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  171

Chapter 28 - Program Options . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 173
General Tab. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  173
Data Entry Tab  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  174
Payment Application Tab  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  174
Aging Reports Tab. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  175
HIPAA Tab/ICD 10  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  175
Color-Coding Tab . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  176

Transactions . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  176
Patients . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  176

Billing Tab . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  176
Statements  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  177
Billing Notes  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  177

Audit Tab  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  178
BillFlash Tab . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  179

Chapter 29 - Backup and Restore Data . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 181
Backing Up Your Data  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  181
Restoring Your Data . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  182
Making a Hot Backup . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  182
Restoring Your Hot Backup  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  182

Chapter 30 - Merge Patients . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 185

Glossary . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 189

Index . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 191



CGM MEDISOFT 27
viii 27 December 2022

 Table of Contents



CGM MEDISOFT 27
December 2022 27  ix

Preface 

Where to Find Help 

Online Help 
Access the online Help screens to find detailed information on each feature in CGM MEDISOFT. 
Online Help is available in two different ways: 

 • Context-Sensitive Help: For help in a particular part of CGM MEDISOFT, click the area for 
which you need help and press F1. The help topic for that area will appear. 

 • Main Help File: To access the main help file, click the Help menu and click CGM MEDISOFT 
Help. The main help file will appear, displaying the Contents tab. Use the Contents tab to view 
categorized topics for CGM MEDISOFT. Use the Index and Search tabs to find out additional 
or specific information about CGM MEDISOFT. 

Training 
There are various training options available. Please contact your local Value-Added Reseller for 
information concerning these options. 

Independent Value-Added Resellers 
There are Value-Added Resellers in your area who are knowledgeable and efficient in selling, 
installing, troubleshooting, and supporting your CGM MEDISOFT program. Search the CGM 
MEDISOFT website at www.medisoft.com for a reseller in your area. 

CGM MEDISOFT Versions

CGM MEDISOFT comes in three versions:

Product Features

Basic Offers basic features for processing patient visits, claims, payments, 
and reporting.

Advanced Offers all that Basic does but provides greater reporting power, the 
ability to process secondary claims, as well as sending patient 
statements and collections processing.

http://www.medisoft.com
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Network Professional Offers all the features of Basic and Advanced, but enables you to 
integrate with an Electronic Health Records (EHR) system.

In addition, with this version only, you can use a mobile device such 
as an iPad, Android tablet, or iPhone to connect to your practice 
data.

Product Features
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Chapter 1 - Navigating in CGM MEDISOFT

In this chapter, you will learn about the basics of navigating in CGM MEDISOFT, using the menus 
and keyboard shortcuts.

Toolbars

There are four toolbars that you use to help you navigate in CGM MEDISOFT.  

Title Bar
The top bar on the screen is the Title bar and it displays the name of the active program and 
contains Minimize, Maximize, and Close buttons on the right side. 

Figure 1.  Title Bar

Menu Bar 

Just below the Title bar is the Menu bar, which shows categories of activities available in CGM 
MEDISOFT. Click one of the headings, such as File, Edit, Activities, Lists, Reports, Tools, screen, 
and Help, to open a submenu with a list of all the options available in that category.  For more 
information on each drop-down menu, see “Menus” on page 3.

Figure 2.  Menu Bar

Toolbar
Below the menu bar is the toolbar with an assortment of speed buttons (or icons) that are shortcuts 
to accessing options in CGM MEDISOFT.  

Figure 3.  Toolbar
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Select the option you want by clicking the appropriate button. To see the function of the toolbar 
button, hover the mouse cursor over it. The value will appear.

Figure 4.  CGM MEDISOFT toolbar with icon highlighted

Customizing the Toolbar
You can customize the toolbar to fit your needs. You can change the order of the buttons in the 
toolbar or remove them so they do not appear. You can create a new toolbar with only the buttons 
or file names that you want. In addition, you can move the toolbar to the top, bottom, or either side 
of the screen or return it to its original position and layout.  

To customize the toolbar:
1. Right-click an open space on the toolbar and click Customize. The Customize screen 

appears.

Figure 5.  Customize screen

2. Use the options on the tabs to make your choices. 
3. Click the Close button when you are done.
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Chapter 1 - Navigating in CGM MEDISOFT Shortcut Bar

Shortcut Bar

Figure 6.  Shortcut Bar

At the bottom of the screen, above the Status bar, is a shortcut bar that describes the available 
shortcut function keys available in the active screen. This bar may also be referred to as the 
“function help bar.” 

Menus

There are eight drop-down menus from the menubar that have options that allow you to work in 
CGM MEDISOFT.
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File Menu

Figure 7.  File menu

The File menu contains options for managing your practice files.  

Edit Menu

Figure 8.  Edit menu

The functions of the Edit menu are Cut, Copy, Paste, and Delete.    
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Chapter 1 - Navigating in CGM MEDISOFT Activities Menu

Activities Menu

Figure 9.  Activities menu

You will use the options on this menu for much of your daily routine. Here is where you enter 
transactions and payments, create claims, view balances, and open Office Hours. 



CGM MEDISOFT 27
6 27 December 2022

Lists Menu Chapter 1 - Navigating in CGM MEDISOFT

Lists Menu

Figure 10.  Lists menu

This menu provides access to the various list screens available in CGM MEDISOFT. Here is where 
you will set up your patients, providers, insurance companies, diagnosis codes, and other basic 
data you will need to file claims and send statements to patients.
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Chapter 1 - Navigating in CGM MEDISOFT Reports Menu

Reports Menu

Figure 11.  Reports menu

Reports within CGM MEDISOFT are accessible through the Reports menu. A wide variety of 
reports enable to you to track your practice and see the state of your practice at any time. 
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Tools Menu

Figure 12.  Tools menu

The options available in this menu help you access peripheral programs and information to help 
you manage your practice.

Window Menu

Figure 13.  Window menu

This menu contains options that control the display of screens in CGM MEDISOFT.  
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Chapter 1 - Navigating in CGM MEDISOFT Help Menu

Help Menu

Figure 14.  Help menu

The Help menu contains access to information on how to use CGM MEDISOFT, as well as how to 
register.  

Keystrokes and Shortcuts

Special keyboard shortcuts reduce the number of times you have to click the mouse or press keys 
to accomplish a task. 
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Common Keystrokes

Keystrokes - List screens

Keystroke Action
F1 Opens Help files in most screens.
ESC Closes or cancels the current function or screen.
F3 Saves whatever you are working on.
F6 Opens a search screen
F7 Opens the Quick Ledger screen. For more information on this screen, 

see “Quick Ledger” on page 109.
F8 Opens a screen to create a new record.
F9 Opens a screen to edit the selected record.
F11 Opens the Quick Balance screen. For more information on this 

screen, see “Quick Balance ” on page 110.
SPACEBAR Toggles a check box (check/uncheck).
ENTER Depends on settings in the Program Options screen. For more 

information, see “Program Options” on page 173.
CTRL + S Toggles the Sidebar display.
CTRL + X Cuts the selected text.
CTRL + C Copies the selected text.
CTRL + V Pastes the text.
ALT + DOWN ARROW Opens drop-down lists.

Keystroke Action
F2 Changes the value in the field.
F3 Saves the record.
F8 Creates a new record.
F9 Edits the selected record.
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Chapter 1 - Navigating in CGM MEDISOFT Keystrokes - Transaction Entry

Keystrokes - Transaction Entry

Keystrokes - Eligibility 

Keystroke Action 
F2 Opens the MultiLink screen. For more information on this screen, see 

“MultiLink Codes” on page 59.
F4 Opens the Apply Payment to Charges screen. For more information on this 

screen, see “Applying a Payment” on page 129.
F5 Opens the Transaction Documentation screen.

Keystroke Action
F10 Opens the Eligibility Verification Results screen when Eligibility is enabled. For 

more information on this screen, see “Eligibility Verification” on page 145.
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Chapter 2 - CGM MEDISOFT at a Glance

This chapter provides a brief overview of the setup and use of CGM MEDISOFT, in the general 
order in which you will want to set up your practice. For instance, you will first want to enter basic 
information on your practice, such as practice name and address. Then, you’ll move on to entering 
information on the physicians in your practice (Providers), the insurance carriers your patients 
have, and then diagnosis and procedure codes. 

For more detail on each area of the program, use the following table:

For more information about setting up... see...

your practice “Creating a Practice and Setup Overview” 
on page 21 and “Entering Practice 
Information” on page 35.

your providers “Setting up Providers and Provider 
Classes” on page 41.

referring providers “Referring Provider Records” on page 45.

insurance carriers “Insurance Classes and Insurance 
Carriers” on page 49.

facilities “Facility Information” on page 53.

addresses “Attorney, Employer, or Other Addresses ” 
on page 55.

procedure/payment/adjustment codes “Procedure, Payment, Adjustment, and 
Diagnosis Codes” on page 57.

diagnosis codes “Diagnosis Codes” on page 65.

patients “Patients” on page 79.
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Setting up Your Practice Overview

You will first set up your practice. The Practice Information screen contains the basic information on 
your practice.

Figure 15.  Practice Information screen

The Provider screen contains important information about the providers/physicians who are part of 
your practice.  

Figure 16.  Provider screen

Each provider in the practice needs to have his or her own record set up in the database. 
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The Referring Provider screen contains information about the referring providers associated with 
your practice.

Figure 17.  Referring Provider screen

You will use the Insurance Carrier screen to enter insurance carrier records. Keep a complete 
record of each ot your insurance carriers so that claims will be filed properly. 

Figure 18.  Insurance Carrier screen

The Facility screen contains information about the labs and facilities associated with your practice. 
Use the fields on this screen to enter information that is specific to the facility for claim filing 
purposes.
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The Addresses screen is used to enter address information important to your practice, such as 
addresses of attorneys, employers, or referral sources.
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The Diagnosis List screen displays diagnosis codes that have been set up for the practice. You can 
also identify codes that are HIPAA Approved. Use diagnosis codes in patient records, as well as 
during transaction entry. These will be part of each claim that is filed.

Figure 19.  Diagnosis screen

You will use the Procedure/Payment/Adjustment Code screen to enter and edit procedure codes. 

Figure 20.  Procedure/Payment/Adjustment screen
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The Patient screen is the main space for entering/editing patient and information.  

Figure 21.  Patient/Guarantor screen
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Entering Transactions and Payments

You enter charges via the Transaction Entry screen. You can also apply payments using this 
feature. 

Figure 22.  Transaction Entry screen

Generating Claims and Statements

Claims processing centers on the Claim Management screen from which you can create, edit, and 
print/send claims. CGM MEDISOFT also provides support for UB-04 claims. 

Figure 23.  Claim Management screen

After you have created claims in CGM MEDISOFT, you can either print them from CGM 
MEDISOFT or file them electronically using Revenue Management (see “Electronic Claims 
Processing” on page 145), an integrated electronic claims filing application.
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You can use the Statement Management screen (available in CGM MEDISOFT Advanced or 
Network Professional) to create billing statements for patients. 

Figure 24.  Statement Management screen
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Chapter 3 - Creating a Practice and Setup 
Overview

In this chapter you will learn how to create a database for your practice and learn about program 
options. 

Creating a Practice

The first step in setting up CGM MEDISOFT is creating the database that holds the data in your 
practice.  

Creating the Practice Database
1. When you first open CGM MEDISOFT after installation, you must either create a new data set 

(if this is the first time you have ever installed CGM MEDISOFT) or convert previous CGM 
MEDISOFT data. 
If you have been using CGM MEDISOFT Version 5.5x or 5.6x and above and have just 
installed Version 27, a message displays stating that data must be converted before you can 
access CGM MEDISOFT. If you have not already created a backup on your existing data, 
create a backup now. Then, click the OK button to perform the automatic conversion.  

If you work with multiple practices, each will have to be converted.    

2. If you choose to create a new data set, the Create a new set of data screen appears. 

Figure 25.  Create a new set of data

3. Fill in the practice name and the practice data path. The data path is the location within the 
MediData folder in which the practice data is stored.

4. When you click the Create button, the Practice Information screen appears. On this screen on 
the Practice tab, enter your basic practice information such as the name of the practice, 
address, and telephone number.

For more detailed information on this screen, see “Entering Basic Practice Information” on page 35.
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Creating Multiple Practices
It is not necessary to install CGM MEDISOFT for each new practice. When the first practice is set 
up, CGM MEDISOFT assumes there is only one practice and establishes a default directory for the 
data for that practice. Each time you set up an additional data set with totally unrelated patients 
and procedure files, you must create a different subdirectory. This establishes a completely 
separate database for the new practice.  

Changing the Program Date
You can change the program date for back-dating a large number of transactions. This affects all 
dates in CGM MEDISOFT except the Date Created setting, which always reflects the System date.  

Opening a Practice

To open a practice: 
1. On the File menu, select the appropriate option.

Figure 26.  Open Practice screen

2. Choose the practice you want to open and click the OK button.  

Setup Overview

Steps to setting up your basic practice can be found at “Entering Basic Practice Information” on 
page 35.

Once you have created your practice database, the next step is to enter data into each of the 
different areas of CGM MEDISOFT, such as insurance carrier records in the Insurance Carrier 
screen, procedure codes in the Procedure, Payment, and Adjustment Codes screen, and so on. 

Here is a sequence for practice setup that will help you enter your practice information in the most 
economical way.  



CGM MEDISOFT 27
December 2022 27 23

Chapter 3 - Creating a Practice and Setup Overview Creating Rules Overview

 • Creating rules overview
 • Set up security
 • Set up preferences
 • Enter basic practice information
 • Set up EDI Receivers for electronic claims and eligibility
 • Enter insurance carrier records
 • Enter facility records
 • Enter provider records
 • Enter referring provider records 
 • Enter other address records
 • Enter procedure codes and multi-link codes
 • Enter diagnosis codes
 • Enter billing codes
 • Enter guarantor and patient records

Keeping in mind your practice structure and your filing needs will help you set up your practice. 

Creating Rules Overview
CGM MEDISOFT claim processing for both print and electronic claims depends on a series of 
flexible rules that you define. When setting up your practice, you will create a series of grid entries 
(rules) on the Practice IDs screen (see “Entering a Practice IDs Rule” on page 35) and Provider IDs 
screen (see “Entering Provider IDs Rules” on page 43). Depending on your practice, you may also 
use the Facility IDs screen (see “Entering Facility Information” on page 53) and Referring Physician 
IDs screens (see “Entering Referring Provider Rules” on page 46). These rules contain your basic 
practice information, such as group or individual NPI numbers, taxonomy, tax IDs, and claim filing 
status (group or individual). They also connect this information to the insurance companies that 
your patients use and the physicians in your practice.

You begin by creating rules for each provider on the Provider IDs screen and at least one rule on 
the Practice IDs screen. These rules will contain information that would apply to the most generic 
situations. Then, you will create other rules that apply to a specific insurance company, insurance 
category, facility, provider, and so on. See “If you are a solo provider (file claims as an individual)” 
on page 24 and “If you are a group (file claims as a group)” on page 26 for more detailed 
information.

When you create claims using Revenue Management, CGM MEDISOFT gathers data for each 
claim using these rules, looking first at rules that apply to an insurance company or provider. It will 
compare these rules against rules set up for facilities or referring physicians. The specific order in 
which CGM MEDISOFT analyzes rules follows the order of fields on the level it is working on. For 
instance, when looking at practice information, it will look first at Providers, then Insurance Carrier, 
and so on, moving from left to right on the grid. 

For instance, if you are setting up a group practice with three physicians,

1. Create at least one rule on the Practice IDs screen for general information that is common to 
all claims. Apply this rule to all providers, all insurance companies, and all facilities (assuming 
you have no facilities associated with your practice or all facilities would use the same details). 
Include your group NPI, taxonomy, and tax ID numbers. 

2. Second, create one rule on the Providers IDs screen for each provider (a total of three rules). 
You must include one rule for each provider on the Provider IDs screen since claim filing status 
(individual or group) is specified there. Each of these rules would be general and could apply 
to all insurance companies and facilities. Select Group for your claim type and select From 
Practice to pull NPI, taxonomy, and Tax IDs from the Practice IDs screen. 
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3. If one of the insurance companies requires a legacy identifier, create a second entry on the 
Practice IDs screen. By creating a second entry on this screen instead of the Provider IDs 
screen, you save time and effort. This one rule can be applied to all the providers at the 
practice level, instead of creating a rule for each provider at the provider level. To do this, for 
this second Practice IDs rule, select the specific insurance company and select all providers. 
Importantly, include your NPI, taxonomy, and Tax IDs since each rule needs to be complete. 
Finally, enter the legacy number the insurance company requires. When the application 
gathers claim data, it will select this row for the specific insurance company and pull the data 
for the claim.

If you are a solo provider (file claims as an individual)
As a solo provider, you have two options when entering key ID numbers, such as NPI, taxonomy, 
and tax ID/social security number.

 • Enter this information at the practice level using the Practice IDs screen (see “Entering a 
Practice IDs Rule” on page 35). With this method, enter these numbers on the Practice ID 
screen. Then, select From Practice for all values on the Provider IDs screen (see “Entering 
Provider IDs Rules” on page 43).

Figure 27.  New Practice ID screen

Enter this information at the provider level using the Provider IDs screen (see “Entering Provider 
IDs Rules” on page 43). In this case, on the Practice IDs screen, select None for NPI, taxonomy, 
tax ID/social security number, and so on, and enter a minimal amount of information. Then, on the 
Providers screen, specify your NPI, taxonomy, tax ID/social security number, and so on. Also, 
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select Individual for the File Claim as.The result will be the same and CGM MEDISOFT will 
correctly pull these IDs when filing claims.

Figure 28.  New Provider IDs screen

NPI Considerations
If you have the same pay-to address as your billing address, you can enter your NPI information on 
the Practice IDs screen. Then, select From Practice on the Providers IDs screen. This will ensure 
that the NPI number appears on all claims.

If you have different billing information and pay to information (see “Entering Practice Information 
for a Billing Service” on page 36), enter your NPI information on the Practice IDs screen. Also, 
enter any unique NPI on the Provider IDs screen. 

If you have insurance companies that require mixed NPI numbers (some require individual while 
some require group), enter your group NPI number on the Practice IDs screen. Then, create 
several rules on the Provider IDs screen specific to the insurance companies that require mixed 
NPI numbers. For insurance companies that require the group NPI, select From Practice for the 
NPI number. This will pull that number from the Practice IDs screen. For insurance companies that 
require an individual NPI number, select National Provider ID and enter the number on the Provider 
IDs screen.

Insurance Company Considerations
You might only need one rule (grid entry). Most likely though, you will probably have at least one or 
more insurance companies that require different information. In that case, you must create other 
rules that are specific to that insurance company and the information needed, for instance a legacy 
qualifier such as a medicare number.

Each of these additional rules needs to be complete since the claims processing pulls all the 
information in a rule and not just one field. An incomplete rule (for instance, no NPI number) will 
leave fields empty in the claim, causing rejection. In the case of Figure , you would need to include 
the NPI number, Taxonomy number, and Social Security Number since those were included in the 
initial rule using the Provider IDs screen (see Figure 28). If you used the Practice IDs screen, you 
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could select From Practice for these numbers and you would not need to specify them on the 
Provider IDs screen since CGM MEDISOFT would pull these values from the Practice IDs screen. 

If an insurance company requires taxonomy, you must create a rule on the Practice IDs screen for 
that insurance carrier and enter the taxonomy number there. Then, open the Insurance Companies 
screen and select the Send Practice Taxonomy in Loop 2000A checkbox. If your practice requires 
dual taxonomy, then you must also create a rule on the Provider IDs screen for that number, 
specifying the provider and insurance company.  

Facility Considerations
If you have facilities attached to your practice, you must create rules on the Facility ID screen for 
any numbers that are specific to that facility. If you have entered a separate NPI number for a 
facility and need to send facility billing information, specify the type of facility and qualifier, 
including the unique facility NPI number. If this information is sent on the claim, select the Send 
Facility on Claim check box and do not include any other data.

Referring Physician Considerations
If your practice has referring physicians, create records for them on the Referring Physicians 
screen and use the Referring Physician IDs screen to enter any numbers unique to a referring 
physician. 

If you are a group (file claims as a group)
First, complete at least one rule on the Practice IDs screen for the practice. Then, create at least 
one rule on the Provider IDs screen for each provider. Set your claim filing status on the Provider 
IDs screen by selecting Group for each provider in your practice.

Figure 29.  New Provider IDs screen with Group selected
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If you have a provider that files claims using a personal NPI number for a specific insurance 
company, create an extra rule for this provider, specifying that particular insurance company. Enter 
the unique NPI number for that rule. 

Figure 30.  New Provider IDs screen with NPI for specific insurance company

NPI Considerations
Enter your NPI information on the Practice IDs screen. Then, on the Provider IDs screen, select 
From Practice.

If you have insurance companies that require mixed NPI numbers (some require individual while 
some require a group), enter your group NPI number on the Practice IDs screen. Then, create 
several rules on the Provider IDs screen specific to the insurance companies that require mixed 
NPI numbers. For insurance companies that require the group NPI, select From Practice for the 
NPI number. This will pull that number from the Practice IDs screen. For insurance companies that 
require an individual NPI number, select National Provider ID and enter the number on the Provider 
IDs screen.

Insurance Company Considerations
If an insurance company requires dual taxonomy, you must create a rule on the Practice IDs screen 
for that insurance company and enter the taxonomy number there. Then, open the Insurance 
Companies screen and select the Send Practice Taxonomy in Loop 2000A checkbox. 

Most likely though, you will probably have at least one or more insurance companies that require 
different information. In that case, you must create other rules that are specific to that insurance 
company and the information needed, for instance a legacy qualifier such as a medicare number, 
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as shown in Figure 31.

Figure 31.  New Provider IDs screen, specific to an insurance company

Each of these additional rules needs to be complete since the claims processing pulls all the 
information in a rule and not just one field. An incomplete rule (for instance, no NPI number) will 
leave fields empty in the claim, causing rejection. In the case of Figure 31, you would need to 
include the NPI number, Taxonomy number, and Social Security Number since those were 
included in the initial rule using the Provider IDs screen (see Figure 30). If you used the Practice 
IDs screen, you could select From Practice for these numbers and you would not need to specify 
them on the Provider IDs screen since CGM MEDISOFT would pull these values from the Practice 
IDs screen. 

Facility Considerations
If you have facilities attached to your practice, you must create rules on the Facility ID screen for 
any numbers that are specific to that facility. If you have entered a separate NPI number for a 
facility and need to send facility billing information, specify the type of facility and qualifier, 
including the unique facility NPI number. If this information is sent on the claim, select the Send 
Facility on Claim check box and do not include any other data.

Referring Physician Considerations
If your practice has referring physicians, create records for them on the Referring Physicians 
screen and use the Referring Physician IDs screen to enter any numbers unique to a referring 
physician. 

Setting Program Options

The Program Options screen contains various default settings that affect operations in different 
parts of the program.  
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To open Program Options:
 • On the File menu, click Program Options.

Figure 32.  Program Options screen

TIP: For most users the default settings on the various tabs on the screen are sufficient for initial 
use. You can customize these settings at a later date.  

 • Each tab features settings for different functional elements in the application. For more 
information on the available options and settings, see: 

 • “General Tab” on page 173
 • “Data Entry Tab” on page 174
 • “Payment Application Tab ” on page 174
 • “Aging Reports Tab” on page 175
 • “HIPAA Tab/ICD 10” on page 175
 • “Color-Coding Tab ” on page 176
 • “Billing Tab ” on page 176
 • “Audit Tab ” on page 178
 • “BillFlash Tab ” on page 179
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Basic security in CGM MEDISOFT is practice-based, with each practice having various users and 
groups. Multiple practices require security setup for each database. Setting up security is a two-
step process:

1. Create users, giving them a login name, password, and access level (1-5). 
The access level determines which areas of the practice a user can access. Level 1 users 
have the most access, while Level 5 users have the least access.

When you create a new practice, a system/administrator user with a password with access 
level of 1(all access) is automatically created for you. The user name for this password is 
SYSTEM and the password is MEDISOFT1 (all capital letters). 

Use these credentials to set up other users with user names and passwords. In addition, be 
sure to create a personal administrative password with access level of 1. Once this is created, 
eMDs recommends that you delete the automatically-created system password.

2. Assign permissions to users, using the five access levels.

Users upgrading
If you are upgrading to CGM MEDISOFT 27, the following rules apply:

 • If there is at least one active User with an Access Level of 1, then this new SYSTEM user will 
not be created.

 • If a converted practice has no active Users with an Access Level of 1 or has no Users created 
at all, then the new administrative User with the Login Name of SYSTEM and the Password of 
MEDISOFT1 will automatically be created. That user's Access Level will be set to 1.

 • If a current user has a password that is shorter than the new minimum length (now set with a 
default of 8 or the length the administrator determines), the user will be prompted to create a 
new password. The user must enter their old password and then they can create a new 
password that meets the new password minimum length and other requirements.  

 • Since current passwords were previously stored as all upper-case, after an upgrade, if a user 
logs in with a password that meets the minimum length requirement and is all upper-case, no 
prompt to change is necessary since it meets the new requirements. However, if a current 
password that meets minimum length requirements but contains any lower-case characters is 
used, this would no longer be a match and you’ll be prompted to create a new password. 
Alternatively that user can log in with all capitals and then change it later if desired. 

If you are deleting users and attempt to delete the last user with a Level 1 access, CGM 
MEDISOFT will present a warning message and prevent you from deleting that user.

Creating Users

You create users of the practice in the User Entry screen. To create a practice
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1. On the File menu, click Security Setup. The Security Setup screen appears. This screen 
shows you a list of all users.

2. Click the New button. The User Entry screen appears.

Figure 33.  User Entry screen

3. Complete the fields on the screen.
Note that the password must be at least 8 characters in length and is case-sensitive.

4. Click the Save button. The Security Setup screen appears and shows you the new user.

Figure 34.  Security Setup screen

Login/Password Management

Use Login/Password Management to set the requirements and application of login rights and 
password usage. For example, you can set the length of valid passwords (minimum of 8 
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characters), the valid time frame in which a password can be used before it has to be changed, 
how long a user has to wait before reusing a password, and so on. 

Figure 35.  Login/Password Management screen

Setting Permissions

NOTE: This is an Advanced or Network Professional feature. 

The Permissions feature provides five levels of access to CGM MEDISOFT. Once you have 
created at least one user for your practice and logged into your practice using someone’s login and 
password, the Permissions options will be available.

To set permissions:
1. On the File menu, click Permissions. The CGM MEDISOFT Security Permissions screen 

appears.
This screen comprises two sections:

 • The screen section displays all the areas of the practice for which security can be set up. 
 • The Process section shows the individual elements, features, or screens that make up the 

selected area in the screen section. 
Level 1 is for unlimited access and is designed to be used exclusively by the Supervisor or 
administrator to restrict access to CGM MEDISOFT. For Levels 2, 3, 4, and 5, the supervisor 
defines what access goes with each level and assigns users based on that.  

2. Select a program area in the screen section. The options for that area appear in the Process 
section.

3. Select or clear check boxes for each option and level in the Process section of the screen.
4. Click the Close button when you are done.
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The Security Supervisor, who has unlimited access and full control of security, can assign or 
remove rights for any level of security, with one exception. Level 1 access cannot be removed from 
any of the three options listed in the Process section of the Permissions screen when Security is 
selected in the screen section. 
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Enter basic practice information that the system uses for reports, statements, and filing claims. Be 
sure to enter complete information so that your claims will be complete. 

Entering Basic Practice Information

To enter practice information:
1. On the File menu, click Practice Information. The Practice Information screen appears. 

Figure 36.  Practice Information screen

2. On the Practice tab, enter the contact information for the practice. The address must be a 
physical address, not a P.O. Box. If you have a P.O. Box to which payments are sent, that 
information will go in the Practice Pay-To tab.

3. From the Type list select your practice type. 
When you select Chiropractic, the Level of Subluxation field appears in the Diagnosis tab of 
the Case screen for entering the level of subluxation. In addition, five treatment fields are 
displayed in the Miscellaneous tab of the Case screen.

4. In the Federal Tax ID field, enter the practice's federal tax ID. 
5. From Practice Type, select Individual or Group. 
6. From Entity Type, select Person or Non-Person.  

NOTE: Extra 1 and Extra 2 are optional fields that may be used if a carrier requires extra data on a 
claim. They can hold up to 30 characters. 

Entering a Practice IDs Rule

Use the Practice IDs tab and Practice IDs grid to enter or edit key data elements associated with 
your practice (tax ID/social security number, NPI, taxonomy, legacy numbers). You will set up at 
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least one rule on the Practice IDs grid and associate this information to all providers, insurance 
carriers, and all facilities. For more information on entering data on the IDs grid, see “Creating 
Rules Overview” on page 23.

1. Select the Practice IDs tab.The Practice IDs tab appears.
2. Click the New button to create a new rule. 


--OR--

To edit an entry, select the record on the grid and click the Edit button. 

3. Select the All, Provider, or Provider Class button. 
4. Select the All button to apply the rule to all providers associated with the practice. 


To apply the rule to a specific provider, select the Provider button and click the magnifying 
glass to select the specific provider. 

To apply the rule to a specific provider class, select the Provider Class button and click the 
magnifying glass to select the provider class.

5. Select the All, Insurance Carrier, or Insurance Class button. 

Select the All button to apply the rule to all insurance carriers associated with the practice. 

To apply the rule to a specific insurance company, select the Insurance Carrier button and 
click the magnifying glass to select the insurance carrier. 

To apply the rule to a specific insurance class, select the Insurance Class button and click the 
magnifying glass to select the insurance class. 

6. Select either the All or Facility button. 
7. Select National Provider ID and enter an NPI number to associate that NPI number with the 

rule.

TIP: if your practice has a group NPI number, enter it here. Then, if providers in your office need to 
file claims as individuals, you can create a rule for that provider using the provider's individual NPI 
number that you enter on the Provider IDs grid. 

8. Select either None or Taxonomy. 
9. Select the Tax Identifier button and enter the tax ID number to associate with the rule.

10. Select the Social Security Number button and enter the social security number to associate 
with the rule.   

11. If needed, enter up to two legacy numbers and qualifiers to associate with the rule using the 
Legacy Identifier 1 and 2 fields. Use these fields to customize your rule to meet filing 
requirements with an insurance carrier(s).

12. Click the Save button.

Entering Practice Information for a Billing Service

Billing Services
If you are a billing service, enter your client’s information in the Practice tab. Enter your information 
in the Practice Pay-To tab. If you want to use CGM MEDISOFT to keep track of your own accounts 
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receivables, a separate database can be set up with each client listed as a patient. Separate 
procedure codes can be created to cover the various services of your billing service.

To set up a billing service:
1. On the File menu, click Practice Information. The Practice Information screen appears.
2. Select the Practice Pay-To tab.

Figure 37.  Practice Information screen - Practice Pay-To tab

3. Enter the pay to information in the Practice Name, Street, City, State, Zip Code fields.
4. Click the Save button.

BillFlash Users

BillFlash is the online service available to you if you want to send your statements electronically. 
Once you enroll with BillFlash, you can create statements and upload them to BillFlash. BillFlash 
then takes care of printing and sending them to your patients.

If you use Bill Flash for electronic statement processing, complete the Statement Pay To tab. Data 
on this tab is used to create a separate pay-to address location for the statements, for instance, a 
PO Box instead of a physical address.

To complete the Statement Pay-To tab: 
1. On the File menu, click Practice Information. The Practice Information screen appears.
2. Select the Statement Pay-To tab.

Figure 38.  Practice Information screen - Statement Pay-To tab
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3. Enter the pay to information in the Practice Name, Street, City, State, Zip Code fields.

NOTE: the Extra 1 and Extra 2 fields are only used if a carrier requires extra data on a claim. 

4. Click the Save button.

EDI Receiver Records

The EDI Receiver screen displays parameters used for transmitting information to a clearinghouse.

To open the EDI Receiver screen:
 • On the Lists menu, click EDI Receivers.

The settings in CGM MEDISOFT on the EDI Receiver screen are used for setting rules for 
electronic claims generation. The actual transmission of claims is done by Revenue Management. 
If you make changes on these tabs in CGM MEDISOFT, the changes flow automatically to 
Revenue Management, and changes made there are also transferred to CGM MEDISOFT.

When sending electronic claims, set up your clearinghouse or direct payers in Revenue 
Management. Once an EDI receiver is set up, Revenue Management will synchronize the EDI 
settings in CGM MEDISOFT. For users upgrading to CGM MEDISOFT 27, Revenue Management 
can use the existing settings for the payors set up on the EDI Receiver screen, but you will need to 
reconfigure receivers to work with Revenue Management.

Figure 39.  EDI Receiver screen
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Set up your providers (physicians) in CGM MEDISOFT so you can add them to patient records and 
transactions entered. In this way their information will be put on claims.   

Entering Provider Information

Enter provider records on the Providers screen. To do so:

1. On the Lists menu, point to Provider and click Providers. The Provider List screen appears. 
This screen shows you all of the providers currently set up in the practice.

Figure 40.  Provider List screen
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2. Click the New button. 

Figure 41.  Provider screen

3. On the Address tab, enter demographic information for the provider such as last name, first 
name, title. 

4. Options:

Select the Medicare Participating check box if the provider is considered a Medicare 
participating provider. A Medicare participating provider agrees to accept assignment on all 
Medicare claims for covered services and supplies. This field is generally used with electronic 
claims.

Select the Signature on File check box to indicate that the provider's signature is on file. Select 
this box if the provider has signed an agreement with Medicare to accept its charges and an 
affidavit is on file. If it is checked, the Signature Date field becomes active to display the date 
on which the signature was placed on file. Enter a date in this field.  

5. In the License Number field, enter the provider's license number.
6. Click the Save button if you are finished with the record or click the Reference tab.


The Reference tab displays data and values before the data was converted to CGM 
MEDISOFT 27 and moved to the Provider IDs grid to create rules for claim creation. The tab 
shows data from the Default Pins and Default Group IDs tabs, which were replaced with the 
Provider IDs tab. 

This tab is mostly used for reference purpose only. You can update data on this tab for your 
reference purposes, but none of this data is pulled for claim generation. The only field that still 
impacts claims is Provider Class. 
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7. Assign a provider to a provider class by clicking the Provider Class list and selecting a class.  

NOTE: Provider classes are set up in the Provider Class screen.

When generating claims, you can use the provider class on the Practice IDs tab to limit a rule 
to a specific class of providers. 

8. Click the Save button if you are finished with the record or select the Provider IDs tab. 

Entering Provider IDs Rules
Use the Provider IDs tab to enter or edit key data associated with a provider (tax ID/social security 
number, NPI, taxonomy, legacy numbers). Set up at least one rule on the Provider IDs grid for each 
provider in your practice and associate this information to all insurance carriers or insurance 
classes and all facilities or a particular insurance carrier or an insurance class. 

For information on creating these rules, see “Creating Rules Overview” on page 23.

To enter rules for a provider:
1. Select the Provider IDs tab.
2. Click the New button to create a new rule. 


--OR--

To edit a rule, select the record on the grid and click the Edit button.

3. Select either All, Insurance Carrier, or Insurance Class. Select a carrier or class if 
necessary.

4. Select either All or Facility. Select a facility if necessary
5. Select either File Claim As Individual or File Claim As Group. 
6. Select either From Practice or National Provider ID. Enter an ID if the NPI is for this provider 

only.
If you do not want to send an NPI number on a claim, select From Practice and then on the 
Practice IDs screen, create a matching entry for the provider in which you select None for the 
NPI option.

7. Select the From Practice button to pull the NPI number from the Practice IDs grid.

WARNING: By selecting From Practice for the NPI, it will put the Practice NPI in the Rendering 
Provider in Loop 2310.

8. Select either From Practice or Taxonomy. 

If you do not want to send a taxonomy number on a claim, select From Practice and then on 
the Practice IDs screen, create a matching entry for the provider in which you select None for 
the Taxonomy option.

Select the From Practice button to pull the taxonomy number from the Practice IDs grid. 

9. Select From Practice, Tax Identifier, or Social Security Number. Select From Practice to pull 
the tax ID/social security number from the Practice ID grid.

10. If you file mammography claims, select Mammography Cert and enter the certificate number 
to associate with the rule.  

11. If you file laboratory claims using a CLIA number, select CLIA and enter the CLIA number to 
associate with the rule.   
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12. If your carrier requires a care plan oversight number, select Care Plan Oversight, enter the 
care plan oversight number, and select an ID qualifier to associate with the rule. 

13. If needed, enter up to three legacy and qualifiers to associate with the rule using the Legacy 
Identifier 1, 2, and 3 fields. Use these fields to customize your rule to meet filing requirements 
with an insurance carrier(s).

14. Click the Save button.
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Many patient visits come to a practice as a result of a referral from another provider. When a 
patient is referred to your practice, create a record for the referring provider. Add data such as the 
Unique Physician Identification Number (UPIN), NPI, tax ID, and so on. In this record, you can link 
the provider to a particular insurance company/category, if needed. 

Entering Referring Provider Information

1. On the Lists menu, click Referring Providers. The Referring Provider List screen appears.

Figure 42.  Referring Provider List screen
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2. Click the New button.

--OR--

Select a record on the Referring Provider List screen and click the Edit button. 

3. On the Address tab, enter demographic information for the referring provider such as last 
name, first name, title. 

Also, if you are sending electronic claims, select from the Specialty list the referring provider’s 
special field of practice. If you need to use a specialty code that is different than the usual 
code, select "Not Listed" and enter your specialty code in the field that appears next to the 
Specialty list. 

NOTE: This field is not used for sending paper claims unless you have modified your claim form to 
include this information.

Entering Referring Provider Rules

Use the Referring Provider IDs tab and grid to enter or edit key data elements associated with a 
referring provider (NPI, taxonomy, legacy numbers). You will set up at least one entry (rule) on the 
Referring Provider IDs grid for each referring provider that works with your practice and associate 
this information to all insurance carriers or insurance classes or a particular insurance carrier or an 
insurance class.  For more information on creating rules, see “Creating Rules Overview” on page 
23.

1. Select the Referring Provider IDs tab. 
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2. lick the New button to create a new grid entry. 

--OR--

Select an entry on the grid and click the Edit button. 

3. Select either All, Insurance Carrier, or Insurance Class. 
4. Select either Entity Type: Person or Entity Type: Non-Person. 
5. Select either None or National Provider ID. 
6. Select either None or Taxonomy. 
7. If needed, enter up to two legacy numbers and qualifiers to associate with the rule using the 

Legacy Identifier 1 and 2 fields. Use these fields to customize your rule to meet filing 
requirements with an insurance carrier(s).

8. Click the Save button.
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Set up the insurance carrier records completely to ensure that your claims are processed in a 
timely manner. You can create insurance classes, into which you can group carriers based on a 
common feature. In addition, create your carrier records. 

Insurance Classes

Use this screen to create insurance classes, such as Blue Shield or Medicare. Use these classes 
to group insurance carriers for easier reporting and payment posting. 

To create insurance classes:
1. On the Lists menu, point to Insurance and click Classes. The Insurance Class List screen 

appears.  

Figure 43.  Insurance Class List screen

2. Click the New button.  
3. Enter an ID, Name, and Description for the class.  
4. Click the Save button.
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Insurance Carriers

1. On the Lists menu, point to Insurance and click Carriers. The Insurance Carrier List screen 
appears. 

Figure 44.  Insurance Carrier List screen

2. Click the New button.

--OR--

Select an entry on the Insurance Carrier List and click the Edit button. 

3. Enter the carrier's information.  
4. From the Class list, select an insurance class to assign to the carrier.  
5. Select the Options and Codes tab. 
6. From the Procedure Code and Diagnosis Code Set lists, select a procedure code set (1, 2, or 

3) and a diagnosis code set (1, 2, or 3) to apply to the insurance carrier. CGM MEDISOFT 
gives you the ability to assign up to three codes to the same procedure. By using this field, the 
claims for each carrier can contain the correct code.  

7. From the Patient, Insured, or Physician Signature on File lists, for each option select, Leave 
blank, Signature on file, or Print name.
These fields control what is printed in the signature Boxes 12, 13, and 31, respectively, on the 
CMS - 1500 claim form, if you are printing claims. These fields do not control whether anything 
is printed in these boxes, but what is printed. Whether anything prints is controlled by settings 
on the Case screen, Policy tab, Accept Assignment and Benefits Assigned field, and Provider 
screen, Address tab, Signature on File field. 
The Signature on file option prints "Signature on File" (if the Signature on file field has been 
activated in the patient and provider records).
The Print name option prints the name of the patient, insured, or physician.
The Leave blank option prints nothing. 

8. From the Print PINs on Forms list select PIN Only or Leave Blank. When setting up Medicare 
and Medicaid carriers for printed claims, select PIN Only; otherwise, select Leave Blank.

9. From the Default Billing Method 1, 2, and 3 lists, select either Paper or Electronic for handling 
primary (1), secondary (2), and tertiary (3) claims. Select Paper if claims are to be printed; 
select Electronic if claims are to be transmitted electronically. 
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10. In the Default Payment Application Codes box select default payment codes.
11. Select the EDI/Eligibility tab. The EDI/Eligibility tab is used for electronic claims.  
12. In the Primary Receiver panel on the EDI Receiver list, select the EDI receiver you use when 

sending electronic claims for primary insurances. If you do not enter an EDI receiver in the EDI 
Receiver field, electronic claims will not be created or sent for this insurance company. 

13. In the Claims Payer ID field, enter the payer ID for the insurance carrier. Refer to the 
enrollment information you received from the carrier/clearinghouse and look up the 
commercial identification number/ submitter identification numbers assigned to the insurance 
company by the clearinghouse.
If you use the eligibility verification service and want to verify eligibility with this insurance 
carrier, in the Eligibility Payer ID field, enter the payer ID (for some carriers, the eligibility payer 
ID is different from the payer ID). Refer to the enrollment information you received from the 
clearinghouse and look up the commercial identification number/ submitter identification 
numbers assigned to the insurance company by the clearinghouse.
From the Type list select a type for the insurance company.

14. Leave Alternate Carrier ID blank. Revenue Management will populate this field if needed.
15. If needed, select from the EDI Max Transactions list, a maximum number of transactions 

accepted by the carrier. This field is available for those carriers that limit the number of 
transactions per claim accepted electronically. If you submit more than the maximum number 
of transactions per claim, CGM MEDISOFT automatically splits the claim.  

16. If the insurance carrier is used as both a primary EDI insurer and a Medigap insurer, in the EDI 
Extra 1/Medigap field, enter the Medigap number. The number entered is the COBA Medigap 
claim-based identifier received from the national Coordination of Benefits Contractor (COBC). 

17. The EDI Extra 2 field is used by Revenue Management.
18. Select the Complimentary Crossover check box if you are filing complimentary crossover 

claims. Secondary insurance will not be sent in the claim file. However, CGM MEDISOFT will 
mark the secondary as sent. If you are sending Medigap claims, do not select this box.

19. Select the Delay Secondary Billing check box, if there is a secondary insurance company and 
you want to delay printing the secondary claim form until a response is recorded from the 
primary carrier. To print the secondary claim form at the same time the primary is printed, 
leave the box empty.

20. Select the Send Ordering Provider in Loop 2420E check box to send ordering provider 
information on an electronic claim.

21. Select the Send Practice Taxonomy in Loop 2000A check box to send taxonomy in Loop 
2000A for electronic claims. Loop 2000A is usually used to report taxonomy for individual 
providers. Contact your carrier for more information on their taxonomy requirements. 

22. Select the Allowed tab. This displays the amount last paid by the selected carrier for each 
procedure code available in CGM MEDISOFT. If you do not enter anything in this table, each 
time a carrier makes a payment on a particular procedure code, CGM MEDISOFT takes the 
amount paid plus any deductible and divides it by the established Service Classification 
percentage to arrive at the allowed amount. 
This allowed amount is used when calculating the patient portion estimate of any procedure in 
the Transaction Entry screen. The existing allowed amount can be changed in the Transaction 
Entry screen by clicking the Allowed Amt column and entering the corrected amount.

23. Click the Save button.



CGM MEDISOFT 27
52 27 December 2022

Insurance Carriers Chapter 8 - Insurance Classes and Insurance Carriers



CGM MEDISOFT 27
December 2022 27  53

Chapter 9 - Facility Information

Setup Scenarios 

If you have a facility or a lab attached/affiliated with your practice, you will need to create a record 
for it. There are two components to the record: contact/demographic data entered on the Address 
tab and billing-specific information entered on the Facility IDs tab. 

A facility or lab is a location to which mail might be sent or calls directed, that has a separate 
address from your practice. 

Entering Facility Information

1. Click Lists and click Facilities.  The Facility List screen appears. 
2. Click the New button.


--OR--

Select a record on the Facility List and click the Edit button.

3. Enter contact data associated with the facility, including a name, address, telephone number.
4. If the facility is a lab, click the Laboratory button; if the facility is not, click Facility.

Entering Facility IDs Rules

Use the Facility IDs tab to enter or edit key data specific to the facility (NPI number, taxonomy 
number, CLIA number, legacy numbers). If your practice is associated with a facility or a lab, set up 
at least one rule on the Facility IDs screen and associate this information to a specific insurance 
carrier or an insurance class. 

If you have entered a separate NPI number for your facility and need to send facility billing 
information for box 32 of the CMS 1500 form, specify the type of facility and qualifier along with the 
facility NPI number. If you need to send it on claims, select the Send Facility on Claim check box.

For more information on creating rules, see “Creating Rules Overview” on page 23.

1. Select the Facility IDs tab. The Facility screen appears.
2. Click the New button to create a new rule. 


--OR--

Select the record on the grid and click the Edit button. 
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3. Select either All, Insurance Carrier, or Insurance Class. 

To apply the rule to a specific insurance carrier, select the Insurance Carrier button and click 
the magnifying glass to select the insurance carrier. 

To apply the rule to a specific insurance class, select Insurance Class and click the 
magnifying glass to select the insurance class. 

4. To include facility information on a print or electronic claim, select the Send Facility on Claim 
box and select an ID Qualifier.   

5. Select either None or National Provider ID. Select National Provider ID and enter an NPI 
number to associate the facility NPI number with the rule.  

6. Select either None or Taxonomy. 
7. Select either None or CLIA.  
8. If needed, enter up to two legacy numbers and qualifiers to associate with the rule using the 

Legacy Identifier 1 and 2 fields. Use these fields to customize your rule to meet filing 
requirements with an insurance carrier(s).

9. Click the Save button.
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The Address file is your address book in CGM MEDISOFT. It keeps the names, addresses, and 
phone numbers of important outside contacts, such as attorneys, employers, referral sources, and 
any other addresses you need.   

The Address file will include all important contact persons whose phone, fax, cell, and e-mail 
numbers the practice needs.  

The addresses maintained in CGM MEDISOFT are classified by “type” assigned to help you select 
them in a drop-down list. These types include: Attorney, Employer, Miscellaneous, and Referral 
Source.  

To set up address records:
1. On the Lists menu, click Addresses. The Address List screen appears.
2. Click the New button on the Address List screen. The Address screen appears.
3. Enter a Code for a new address record or leave the field blank and let CGM MEDISOFT create 

a unique code. 
4. Enter demographic data for the address.  
5. From the Type list, select Attorney, Employer, Miscellaneous, or Referral Source.
6. Enter other demographic data such as phone numbers and email address. 
7. Click the Save button.
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and Diagnosis Codes

In this chapter you will learn about entering procedure and diagnosis codes that are used when 
you enter charges for your patients. 

Procedure, Payment, and Adjustment Codes

Procedure codes are used to communicate procedure information between patient, provider, and 
third-party payers.   

The Procedure/Payment/Adjustment List screen shows what codes have been set up.

Figure 45.  Procedure/Payment/Adjustment List screen

At the top of the screen, there are two fields to help you find a procedure code:  Search for and 
Field. Field defaults to Type but you can change it to Code 1 or Description. If you are not sure of 
the complete code, description, or type, enter the first few letters or numbers in the Search for 
field. As you type, the list automatically filters to display records that match.
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General Tab
Enter a new code number, description, and type in the General tab.  

Figure 46.  Procedure/Payment/Adjustment screen

Amounts Tab
The Amounts tab links to the Price Code field on the Account tab of the Case screen.  CGM 
MEDISOFT Advanced and CGM MEDISOFT Network Professional allow 27 charge amounts for 
each code entered in CGM MEDISOFT. The applicable charge amount is selected in the Account 
tab of each patient’s Case screen. 
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Allowed Amounts Tab (Advanced and CGM MEDISOFT Network 
Professional)

The Allowed Amounts tab keeps track of how much each insurance carrier pays for a particular 
procedure. CGM MEDISOFT calculates the allowed amount based on the amount paid, any 
applicable deductible, and the service classification.  This amount is used in calculating the patient 
portion of any transaction entered in Transaction Entry.  

MultiLink Codes

MultiLink Codes are groups of procedure codes combined as a single code. They are for 
procedures that are normally performed at the same time, for example, for a physical exam or a 
routine set of treatments.

There are two advantages to using MultiLinks:

 • You reduce data entry time by creating several transactions at once with a single code.
 • You reduce omission errors since you’ve already included all applicable codes in your 

MultiLink code. 

To create MultiLink codes:
1. On the Lists menu, click MultiLink Codes. The MultiLink List screen appears.
2. Click the New button. The MultiLink Code screen appears.
3. Enter a Code and Description for the procedure.
4. Select the procedures for this code from the Link Code fields. 
5. Click the Save button. 

CPT Code Search

You can use the CPT Code search feature to search for CPT/Procedure codes and add them to 
your practice. 

Note: This is an add-on feature to CGM MEDISOFT 22 and will work only for CGM MEDISOFT 22 
and above. For information on purchasing CPT Code Search, contact your Value-Added Reseller. 
Once you purchase CPT Code Search, you must register it to activate it. 

In addition, Internet is required to use CPT Code search.

With this feature, you can add either

 • A single code--Find CPT button on the Procedure/Payment/Adjustment Code screen

 • Multiple codes--Add CPT Codes button on the Procedure/Payment/Adjustment Code List 
screen
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New CPT Code Search screen (single code search)
Use this screen to search for a CPT/Procedure code and add it to your practice. 

Figure 47.  CPT Code Search screen

The table below describes the fields and elements on this screen.

Element Description

Search for Use this field to type in characters that you want to 
search for.

Effective Date Select an Effective Date for when the code will 
become active for your practice.

Show Matches Only check box Select this check box if you want to see exact 
matches only.

Search button Click this button to perform the search for the code 
you entered.

When you click this button, the “tree” listing of 
codes in the code section will expand to show you 
the code you searched for.

OK button Click this button to add the code to your list of 
Codes.

Cancel Click this button to cancel your search and close 
the screen.
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New CPT Code Search screen (multiple code search)
Use this screen to add more than one CPT code to your code set at once. 

Figure 48.  CPT Code Search screen (multiple code search)

The table below describes the fields and elements on this screen.

Element Description

Search for Use this field to type in characters that you want to 
search for.

Effective Date Select an Effective Date for when the code will 
become active for your practice.

Show Matches Only check box Select this check box if you want to see exact 
matches only.

Search button Click this button to perform the search for the code 
you entered.

When you click this button, the “tree” listing of 
codes in the code section will expand to show you 
the code you searched for.

Check boxes in grid Select the check boxes in the grid for the codes 
you want to add. Selecting a check box for an 
entire group of codes will add the entire group to 
your database at one time.

Default values for selected codes section
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Procedures

Adding a new code on the Procedure/Payment/Adjustment Codes screen
To add a new code on the Procedure/Payment/Adjustment Codes screen

1. On the Lists menu, select Procedure/Payment/Adjustment Codes. The Procedure/Payment/
Adjustment Codes screen opens.

2. Click the New button.

3. Click the Find CPT button. The CPT Code Search screen opens.

4. Enter the code you are searching for in the Search For field.

5. Click the Search button. The code will appear in the section below, with the code tree opening 
to show you the code and its description.

6. Highlight the code and click the OK button. The code will appear in the Procedure/Payment/
Adjustment (new) screen.

Adding multiple codes from the Procedure/Payment/Adjustment List screen
To add multiple codes at once:

1. On the Lists menu, select Procedure/Payment/Adjustment Codes. The Procedure/Payment/
Adjustment Codes screen opens.

2. Click the Add CPT Codes button. The CPT Code Search screen opens.

3. Enter a code to search for or use the code tree in the grid to find a group of codes to add. 

4. Select the check boxes to the left of the codes you want to add.

Type of Service Enter the Type of Service that will apply to the 
selected codes.

Place of Service Enter the Place of Service for the selected codes.

Revenue Code Select a Revenue Code (if applicable) from the 
drop-down menu.

Modifiers Enter the modifiers that will apply to the selected 
codes.

Taxable check box Select the check box if the selected codes are 
taxable.

Select All button Click this button to select all of the codes in the 
grid. In this way, you can add the codes at one 
time.

OK button Click this button to add the codes to your list of 
Procedure Codes.

Cancel Click this button to cancel your search and close 
the screen.

Element Description
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5. Enter additional information for Type of Service, Place of Service, Modifiers, and so on as 
necessary.

6. Click the OK button. The codes will appear in the Procedure/Payment/Adjustment List screen.
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Diagnosis codes describe the medical the reason(s) a service is provided. The procedure 
code tells what the physician did and the diagnosis code tells what the physician found.  

To create a new Diagnosis Code

1. On the Lists menu, select Diagnosis Codes. The Diagnosis List window appears.

Figure 49.  Diagnosis List window

2. Click New. The Diagnosis window appears. 

Figure 50.  Diagnosis window

3. Enter the correct Code and a Description. 
4. If necessary, enter Alternate Code Sets. YOu can use these for entering codes for 

different carriers but for the same diagnosis.  
5. Click Save.
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IMO - Enhanced ICD Search
The current ICD-10 code search tool for CGM MEDISOFT has been replaced by Intelligent 
Medical Objects® (IMO®).

You must be registered to use this feature. When you first use this feature, you’ll see a 
screen for registration information. Enter the information you received from your Value-
Added Reseller (VAR). The Account ID is case-sensitive

For the Value-added reseller: The Customer Account ID in Salesforce is the Customer 
Account ID in CGM MEDISOFT.

Figure 51.  Account Registration screen

When you click the ICD-10 Look up button on the CGM MEDISOFT Diagnosis (new) 
screen, the new search screen will open. 

Figure 52.  Diagnosis (new) screen
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When you first open Diagnosis Code Search, it will appear like this:

Figure 53.  Diagnosis Code Search screen

Searching for and selecting codes

Searching for codes
Search for a code by entering the code description or part of the description. The type 
ahead search feature will display codes automatically after you have entered three 
characters. Then, either scroll through the list of results or continue to type in the 
description to refine the search.

Figure 54.  Diagnosis Code Search screen - type ahead results
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You also can type a search term or partial search term (for instance, one or two 
characters) and press Enter. 

Figure 55.  Diagnosis Code Search screen - Enter key pressed

Codes that were located appear in the section below the Search field. When the search 
results include a diagnosis with multiple ICD-10 codes, a plus sign (+) displays next to the 
diagnosis code. 

Figure 56.  Diagnosis Code Search screen - + sign highlighted

Selecting such a code by clicking the radio button to the left of it will display all diagnoses 
associated with that item.

Figure 57.  Diagnosis Code Search screen - Code Selection section highlighted
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You can also hover over or click the plus sign (+) to display a screen that shows the 
additional ICD-10 codes for the diagnosis code.

Figure 58.  ICD-10 Codes modal

Selecting codes
To select a code, click the radio button to the left of the code in the main search section.

Figure 59.  Diagnosis Code Search screen

The selected code will appear at the right in the Code Selection section, with the radio 
button selected there (if there is only one item for the selected code).

To add the code to your list of codes in CGM MEDISOFT, click the OK button in the bottom 
right. On the CGM MEDISOFT Diagnosis screen the Description, ICD-10 Code and 
Description fields will be populated. 

Then, click the Save button on the Diagnosis screen in CGM MEDISOFT.

Note: if you enter an ICD-10 code in the CGM MEDISOFT New Diagnosis screen before 
you click the ICD-10 Lookup, the Search screen will be scoped to related items when you 
launch it. 
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For items that have multiple codes, when you click the radio button to the left of the item in 
the search, all codes for that item will appear in the Code Selection section on the right.

Figure 60.  Diagnosis Code Search screen

In this case, to select a code, select one of the radio buttons in the Code Selection section. 
Then, click the OK button. 

Note that you can add only one code at a time to your CGM MEDISOFT Diagnosis Code 
list.

To de-select a code, select a different radio button or click the Cancel button on the bottom 
right to close the Diagnosis Code Search screen.

Viewing and hiding code types
By default, only ICD-10 codes will display in the search results when opening the 
Diagnosis Code Search screen. However, you can choose to view ICD-9 and SNOMED 
codes by clicking the View (Show/Hide) icon shaped like an eye.

 • The View (show) icon will display for code types that are marked for display.

 • The View icon with a slash (hide) will display for code types that are hidden.

Figure 61.  Code Types
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When all code types are displayed, the screen will appear like this:

Figure 62.  Diagnosis Code Search screen

Hovering over an ICD-10 code will display the information for that code. 

Figure 63.  Diagnosis Code Search screen - hover over displayed

Click the ICD-10 code and a modal screen will open showing the information. 

Figure 64.  ICD-10 Codes modal
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Viewing and selecting modifiers
The More Options button (ellipsis) indicates that there are modifiers available for the 
diagnosis code. The use of the term modifier refers to qualifying, or refining, the diagnosis 
code and has no impact on billing.

Figure 65.  Diagnosis Code Search screen - with More Options button highlighted

Click the More Options button to open a screen that displays modifier groups that allow you 
to refine the search results.

Figure 66.  Diagnosis Modifiers screen

When you select a modifier item in one of the category boxes, a more specific list of 
modifier results will display in the Results section. The system will hide all incompatible 
modifier items in the other modifier groups, as well as all items in the active modifier 
container. Only one selection per modifier group is allowed.

To de-select a modifier, click it again. All of the modifiers and categories will be restored. 
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Figure 67.  Diagnosis Modifiers screen - Results highlighted

Note in the figure above that the selected item is now highlighted in light blue. 

You can continue to make selections to narrow the results. For instance, after selecting 
type 1 or type 2 in the Diabetes mellitus type category box, selecting without 
complication from the Diabetes mellitus complication status box will reduce the results 
to a single item and without complication is also highlighted.

Figure 68.  Diagnosis Modifiers screen

Selecting modifiers
Click all necessary diagnosis modifiers in the category boxes to refine the search. Then, 
click the Select button in the Results section to select the desired code. You can select 
only one code.

Figure 69.  Diagnosis Modifiers screen
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Then, the Diagnosis Modifier screen will close and the selected code will display in the 
Code Selection section of the Diagnosis Code Search screen. If multiple codes appear, 
select the one you want in the Code Selection section.

Figure 70.  Diagnosis Code Search 

Then, click the OK button to add the code on the Diagnosis (new) screen.

Finally, click the Save button on the CGM MEDISOFT Diagnosis screen.

Risk Score display
If an IMO diagnosis code has risk score results, an HCC (for Hierarchical Condition 
Categories) icon appears at the far right of the description. Hover your mouse pointer over 
this icon to display the risk results data. The data displays in two columns: RxHCC 
Information and HCC Information.

Figure 71.  Diagnosis Code Search screen - Risk hover over

Although the HCC Risk Category information is displayed for some codes, this information 
is not included in nor automatically carried over to the Diagnosis Code list in CGM 
MEDISOFT. It is provided for information and not used elsewhere for a selected diagnosis.
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A billing code is a user-defined two-character alphanumeric code used in sorting and grouping 
patient records for billing purposes. A billing code range is a filter available in most reports printed 
in CGM MEDISOFT as well.

To enter a billing code:
1. On the Lists menu, click Billing Codes. The Billing Code List screen appears.

Figure 72.  Billing Code List screen

2. Click the New button. The Billing Code screen appears. 
3. Enter a Code and Description. 
4. Click the Save button.
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NOTE: This is a CGM MEDISOFT Advanced and CGM MEDISOFT Network Professional feature. 

The Contact List is available to track people with whom you have had contact during the course of 
business. On the Contact screen, you can add notes regarding your conversations with the contact 
to help you keep track of what was discussed and any conclusions or information shared during 
the conversation.  

To add a contact:
1. On the Lists menu, click Contact List.The Contact List screen appears. 
2. Click the New button. The Contact screen appears.
3. Select the Category for the new contact. 
4. Enter information as necessary to complete your record.
5. Click the Save button.
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One of the most important functions in getting your practice set up is entering patient 
data. Complete patient information is important for filing claims and processing statements to bill 
your patients. 

Chart Number Considerations

Every patient or guarantor must have a chart number and be set up in the database before you can 
enter transactions for the patient. You can choose to allow CGM MEDISOFT to create your 
patients’ chart numbers as you enter their records or you can use your own system. 

 • If you want CGM MEDISOFT to create your chart numbers, simply leave that field blank when 
you create a patient record. 

 • If you want to use your own system, complete the Chart field as you enter the new patient’s 
information.   

If you want to use numeric chart numbers only, open Program Options, select the Data Entry tab, 
and select the Use numeric chart numbers check box.  

There is no need for corresponding numbers within a family; the number sequence has little 
bearing on grouping of patients. Each patient is set up individually in CGM MEDISOFT and 
individual bills are prepared for each guarantor.

Once assigned, the Chart Number cannot be changed. To correct a wrong chart number, you must 
delete the entire patient record and create a new one with the proper chart number.  

All other data in the patient record can be modified.
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Entering Patient Information

1. On the Lists menu, click Patients/Guarantors and Cases. The Patient List screen appears.

Figure 73.  Patient List screen

2. Click New Patient. The Patient/Guarantor screen appears.
3. On the Name, Address tab, enter all known or necessary information.

Tip: In CGM MEDISOFT Advanced and CGM MEDISOFT Network Professional, you can establish 
default information, applied to all new patient records. Enter the information that is the same for all 
of your patients, and then click Set Default. To remove your new default settings, hold down CTRL 
and the button name changes to Remove Default.

When you enter a Social Security number, CGM MEDISOFT checks through the patient 
records for any duplications. If a number you enter is a duplicate, CGM MEDISOFT displays 
the name and chart number of the patient having that Social Security Number.

4. Select the Other Information tab. 
5. Complete the fields here.  

If the patient’s employer record has been set up in the Address file (see “Attorney, Employer, or 
Other Addresses ” on page 55), select it on the Employer field. 

If you want to create a new address record, place the cursor in the Employer field and press F8. 
The Addresses screen will appear.

6. Select the Payment Plan tab. Select a Payment Code to set up the payment terms for the 
patient.

Patient Alerts
You can create Patient "Alert Codes," which can be assigned to a patient from the patient level. 

Each patient can have up to five Patient Alert Codes assigned to them, as well as one free-text 
alert. These alert codes are user-defined and user-created and can be assigned in the patient 
record. The Patient Alert Codes can be used as warning messages to the practice, assigning a 
status, as a reminder to the practice, categorize the patient into a group, and so on. 

You can set up alerts to open on one or up to four screens in CGM MEDISOFT, based on 
selections you make when creating the alert:
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 • If the Display on New/Edit Transaction Entry is checked, a pop-up window will open with the 
alert(s)  when the user creates or edits a transaction for the patient. The alerts will display 
immediately after the patient is selected.

 • If the Display on New/Edit Patient is checked, a pop-up window will appear with the alert(s) 
when the user creates or edits a patient. The alerts will display immediately after the patient is 
selected.

 • If the Display on New/Edit Case is checked, a pop-up window will appear with the alert(s) 
when the user creates or edits a case for the patient. The alerts will display immediately after a 
case is selected.

 • If the Display on New/Edit Appointment in Office Hours is checked, a pop-up window will open 
with the alert(s) when the patient is selected on a new or edited appointment in Office Hours. 
The alerts will display immediately after the patient is selected.

Free text alert will display on all of the above. 

If multiple Patient Alert Codes are chosen for a patient and that patient is chosen in one or more of 
the four optional pop-up areas of CGM MEDISOFT, all selected messages will appear in one 
window.

Patient Alerts list
Use this window to view, search for, and filter alerts that have been created. Use it also to create, 
edit, and delete existing alerts.

Figure 74.  Patient Alerts List screen

The table below describes the elements on this screen.

Elements Description

Search for Enter a Code to search for. As you type 
characters, the grid will automatically filter. 

? button Click to open the Locate Patient Alert screen, 
which you can use for advanced searching.

Field Select the type of data to search for, either Code 
or Description
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Patient Alert Code Entry
Use this screen to create and edit alerts. You can give the alert a description and specify on which 
areas of CGM MEDISOFT you want the description/message to open.

Figure 75.  Patient Alert Entry screen

The table below describes the elements on this screen.

grid This shows you the list of codes. 

Note that in the Description column, you will only 
see the first line of an Alert Codes that have 
multiple lines in their Description fields.

Edit button Click this button to edit a selected alert in the grid.

New button Click this button to create a new alert.

Delete button Click this button to delete a selected alert in the 
grid.

Print Grid button Click this button to print the information in the grid.

Close button Click this button to close the List screen.

Elements Description

Element Description

Code 1 Use this field to enter a code for the alert, up to 9 
characters.

Inactive Select this check box to mark the alert as 
inactive.
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Other Information tab
The Other Information tab of the Patient screen includes fields for up to five Patient Alert codes and 
one Free Text alert. Use these fields to select the codes or enter free text that you want to display 
when the patient is selected in the designated areas.

Figure 76.  Patient screen - Other Information tab

In addition, there is an optional sixth, user-defined alert that is specific to that patient.

Description Use this field to enter a description of the code. 
This information will appear on the Alert Popup 
when it is triggered on one of the 4 screens. 

This field can be up to 70 characters.

Display on new/edit Appointment in Office 
Hours

Select this check box if you want this alert to 
display when a patient is selected in Office Hours 
appointments.

Display on new/edit Transaction Entry Select this check box if you want this alert to 
display when a patient is selected in Transaction 
Entry.

Display when editing Patient Record Select this check box if you want this alert to 
display when the patient’s record is opened.

Display on new/edit Case Select this check box if you want this alert to 
display when the patient is selected for the case.

Save button Click this button to save the new alert or the 
changes for an edited alert.

Cancel Click this button to close the window without 
saving the alert or changes to an alert.

Help Click this button to open the Help for this screen.

Element Description
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The drop-down arrow to the right of the Patient Alert Code field will display the list of existing alerts, 
as well as the settings of the check boxes for that alert.

Figure 77.  Other Information tab - Patient Alert Codes section

Clicking the magnifying glass to the right of the Alert Code field will open a search window that you 
can use to find a particular code.

Figure 78.  Search window
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Patient Alert Code Messages screen
This screen will open when an alert is triggered for the patient.

Figure 79.  Patient Alert Message

When the alerts are displayed in the pop-up window, they display  in the order of the code field in 
the patient.

The message will show ALL of the alerts specified for that patient in that area. For example: if you 
have 2 alerts flagged to display in Transaction entry and 1 to display in appointments, when you 
launch transaction entry for that patient, you will see the 2 transaction entry alerts; you will not see 
the one flagged for the appointment. 

You have the option in certain places of deleting an alert from the patient’s record. When you click 
on an alert, it will turn Red to indicate which one is selected to delete. If you click on it again to de-
select it from deletion it will turn black again.  If there are no red items, the cancel button will be 
removed.

When you do, the Cancel button will appear at the bottom of the screen.

 • When you are done, click OK. Any codes you selected for deletion from the patient’s record will 
be deleted and you can continue your work.

Click Cancel if you have clicked on the X to delete and change your mind to keep the alerts in the 
patient’s record. Then, click OK to close the screen and continue your work.

Due to record-locking limitations, the Delete from Patient option on the pop-up window is not 
available when the pop-up displays when accessing the Patient or from Transaction entry.
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Transactions in CGM MEDISOFT are generally case-based.  A case is a grouping of procedures or 
transactions generally sharing a common treatment, facility, or insurance carrier. You can set up as 
many new cases as needed for your patients, depending on changes to their insurance, treatment, 
diagnosis, and so on. For instance, you are treating a diabetic patient regularly and he is injured on 
the job. His visits regarding the work-related injury should be kept in a Workers’ Compensation 
case, totally separate from regular visits, for legal and reporting reasons. Ideally, you would have a 
case for each different malady from which the patient suffers. Then, you can pull up groupings of 
case visits to help you evaluate the patient’s overall health status.  By pulling a case that contains 
all diabetic treatments, one for high blood pressure, one for angina, and one for cancer, you get a 
better picture of the full range of health problems.  

TIP: If a patient comes for a one-time treatment, you can create a transaction for that treatment 
without creating an entirely new case. Just select different diagnosis codes in Transaction Entry 
when creating the transaction.

Creating a Case

To create a new case for a patient:
1. On the Lists menu, click Patients/Guarantors and Cases. The Patient List screen appears.
2. In the top right of the screen, click Case. The buttons on the Patient screen change.

Figure 80.  Patient screen with Case selected
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3. Click the New Case button. The Case screen appears. 

Figure 81.  Case screen - Personal tab

CGM MEDISOFT will pull information from the patient’s record into the case record 
automatically. 

4. Complete the fields on each tab as is applicable for the new case. Be as complete as you can, 
since much of this information will be sent when you file claims. 

Tab Description

Personal Use this to enter general information on the new case and 
employer information.

Account Use this to enter the provider, referral, and attorney 
information set up in the Address file. Also enter billing and 
price codes and information on visit authorization, including 
the number of visits.

Diagnosis Use this to enter diagnosis codes for this case.

Condition Use this to enter information pertinent to the illness, 
pregnancy, or injury, and tracking of symptoms. Also enter 
dates relative to the condition, plus Workers’ Compensation 
information.

Miscellaneous Use this to enter supplemental information such as lab work 
charges, whether the lab is in-house or outside, Referral and 
Prescription Dates, Local Use A and Local Use B fields, case 
Indicator code, and prior authorization. 
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5. Click the Save button.

Copying a Case

In CGM MEDISOFT, you can copy an entire case to help save you time. To do so

1. On the Lists menu, click Patient/Guarantor and Case. The Patient List screen appears.
2. Highlight the patient whose case you want to copy. The existing cases for that patient appear 

in the right pane of the Patient screen.
3. Highlight the case you want to copy. 
4. Click the Copy Case button.
5. The Case screen appears with the data copied.
6. Modify the case data for the new case.
7. Click the Save button.

Policy 1, 2, 3 Use this to enter up to three insurance carriers for the patient, 
including policy and group numbers, and Insurance Coverage 
Percents by Service Classification (how much the carrier 
pays for certain types of procedures). The service percentage 
classification is tied to each procedure code.  

A Deductible Met check box is provided in the Policy 1 tab.  
When the patient meets his or her deductible obligation for 
the year, select this check box and the status is displayed in 
the patient account detail of the Transaction Entry screen.  

The three tabs have the same layout, except Policy 1 has 
fields for Capitated Plan and Co-Pay Amount and has the 
Deductible Met check box; Policy 2 has a field for Crossover 
Plan; and Policy 3 can be set up for tertiary or third-party 
involvement.

Medicaid and 
TRICARE

Use this to enter all submission numbers, reference, and data 
for each carrier. Also, enter branch of service information. 
Within the Medicaid and Tricare tab are EPSDT and Family 
Planning indicators, required submission numbers, and 
reference data for the case.  It also includes service 
information for TRICARE claims.

Multimedia tab 
(Network Professional 
only

Use this to add images to your patient records.

Comment (Advanced 
and CGM MEDISOFT 
Network Professional)

Use this to enter notes to be printed on statements.

EDI Use this to enter information for electronic claims specific to 
this case.

Tab Description
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Customizing the Case screen

In CGM MEDISOFT Advanced and CGM MEDISOFT Network Professional, you can customize 
the display of the tabs. If you do not need a tab, you can hide it. 

1. With the Case screen open, right-click on any tab header. A list of the tabs appears. A check 
mark appears next to the tabs that are currently displayed .

2. Click one of the tabs to deselect it. The tab is now hidden.
3. To display the tab again, right-click any tab header.
4. Click the hidden tab to place the check mark on it. The tab appears again.

Scanning
You can scan insurance cards, and other documents, directly into CGM MEDISOFT.

Supported scanners
The scanning feature requires the use of a TWAIN-compatible scanner.

For reference, the following scanners were used in successful testing of the scanning feature.   
This is not an exclusive list and other TWAIN-compatible card scanners may also be compatible.  

 • ScanShell  800DX and 800DXN

 • ScanShell 800N, 800R,  800NR

 • ScanShell 1000N, 1000A, 1000NA

 • ScanShell 2000N

 • Ambir DS490

 • Ambir DS687

 • Ambir PS667

 • Ambir PS600

 • TTScanner

 • Fujitsu 6130z

 • Brother MFC 8680DN

 • Canon PIXMA MX 452

Important notes:

 • eMDs does not provide support for individual scanner hardware or software questions.
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 • if you are working with Terminal Services or a Remote Desktop Protocol, you will need 
additional software to connect a scanner to CGM MEDISOFT, such as TSscan. Also, eMDs 
recommends that you close CGM MEDISOFT prior to disconnecting a remote session.

 • Be sure to set up and install the scanner on your computer or network before attempting to 
scan images from within CGM MEDISOFT.

 • New installations may change the previously-selected scanner. Be sure to check which 
scanner is selected prior to performing a scan.

Scanning tips
 • eMDs recommends that you use a dedicated insurance card scanner for scanning insurance 

cards.

 • Since scanning images into your database will increase its size and possibly affect the 
performance of CGM MEDISOFT, use the lowest acceptable resolution and size for your 
images

 • When using duplex, insert the insurance card slightly off the side rail (sometimes a ¼ to ½ 
inch). This will cause the duplex images to be centered on the scan page. Additionally, the 
card should be inserted with the long-edge into the scanner, usually upside down and top-in. 

Case - Policy tabs
The Policy tabs have fields and options that allow you to scan insurance cards. Once the card is 
scanned, you can preview the front and back images for the card.

Figure 82.  Case - Policy tab

The table below describes the fields and buttons on this section.

Element Description

Front Card radio button Select this button to scan or view the front of the 
insurance card.

Back Card radio button Select this button to scan or view the back of the 
insurance card.

Delete icon Click this icon to delete the selected scan.

Note: These icons only appear when there is a 
scan for the front or back card or both.
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Scanning tip
If you accidentally scan an insurance card to the wrong insurance policy and no longer have 
access to the card, you can use the following steps to move the scans from one Policy tab to the 
other.

1. Open the case and the Policy tab that has the wrong scan.

2. Select the Front Card. 

3. Double-click the scan in the preview pane. This will open the Multimedia entry screen.

4. Click the Save to File button.

5. Give the scan a name and save it. 

6. Click Cancel on the Multimedia Entry screen.

7. Select the Policy tab where you want the scan to be saved.

8. Select the Front Card radio button and click Scan. The Multimedia Entry screen opens.

9. Click the Load from File button.

10. Find the file you saved and click Open.

11. Click Save. The scan appear on the Policy tab.

12. Click Save on the Case screen.

13. Repeat for the Back Card scan. 

14. On the Policy tab that has the wrong scan, click the X button next to Front Card and Back Card 
to delete the incorrect scans. 

Multimedia Entry screen
You can also use the Multimedia Entry modal to scan an image into CGM MEDISOFT from within 
the screen.

Scan button Click this button to scan a card or load an image 
from a file. Clicking this button will open the 
Multimedia Entry modal.

This button will be disabled if there are already two 
images (one for front and one for back) scanned 
for the policy and case. If you need to change the 
card, first delete the existing scans and then you 
will be able to scan the new card.

Preview area This area shows you a preview of the card. This 
area is gray when no image is selected.

Clicking the image will display the image in the 
multi-media modal.

Element Description
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The table below describes the elements on this screen.

Element Description

Description Use this field to enter a description of the image 
you are scanning. 

Note: if you open this screen from a Policy tab, the 
description will be either “front card” or “back card”, 
depending on which radio button is selected on 
the Policy tab.

Note Use this field to enter a note on the image you are 
scanning. The information you enter here will not 
appear on the Policy tab but will be available if you 
double-click the image preview on the Policy tab.

Show on Patient Screen Select this check box if you want to scan to 
appear as a thumbnail on the right side of the 
Patient’s record. 

Note: this check box is hidden when you open the 
Multimedia Entry screen from the Policy tab. 
Scans made from the Policy tab are for insurance 
cards only. 

Scanner Name Use the drop-down to select a scanner. Only the 
last-used scanner (per Windows user) will appear 
when you open the Multimedia Entry modal and 
use the drop-down. To get a full list of scanners, 
click the Refresh Scanners button.

This drop-down will be empty until you click the 
Refresh Scanners button. At that time, a list of 
scanners will appear. Once you have scanned 
and saved, the scanner name will automatically 
appear in the drop-down.

Note: scanners must be installed or set up prior to 
using this feature. For a list of supported 
scanners, see “Supported scanners” on page 90.

Refresh Scanners button Click this button to refresh the list of scanners that 
will appear in the Scanner Name drop-down.
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Disable duplex check box Select or clear this check box when using a 
duplex scanner to choose single sided or duplex 
scanning. If the system can detect your scanner 
only allows single sided this will be disabled. 

If you clear this check box, the scanner will scan 
both sides of the document and create a single 
image with both sides. if you opened the 
Multimedia Entry modal from a Policy tab, the 
combined image will be placed in the selected 
option on the Policy tab, either front card or back 
card.

Color radio button Select this option if you want to scan in color. 

Note: scanning in color can increase the size of 
the image file.

For best contrast and readability, color is the best 
scanning method.

Black White radio button Select this radio button if you want to scan in black 
and white.

Resolution Use this field to select the resolution.

Note: higher resolutions will create larger image 
files. eMDs recommends that you use the lowest 
setting that creates an acceptable image. 

Scan button Click this button to scan the image. The 
completed, scanned image will appear in the 
preview area below. 

Zoom in Click this button to zoom in on the scanned image 
in the preview area.

This is for viewing only. You cannot save the 
zoomed image.

Zoom out Click this button to zoom out on the scanned 
image in the preview area.

This is for viewing only. You cannot save the 
zoomed image.

Crop Picture Click this button to crop the scanned image. 

You must select the area to be cropped before 
clicking this button.

Rotate Right 90 Click this button to rotate the image right 90 
degrees.

Rotate Left 90 Click this button to rotate the image left 90 
degrees.

Element Description
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Flip Horizontal Click this button to flip the image horizontally.

Flip Vertical Click this button to flip the image vertically.

Image area This section of the screen shows you the scanned 
image.

Image thumbnail The image thumbnail appears to the right of the 
image preview area.

Print Image Click this button to print the image on paper.

Save to File Click this button to save the image as a file on 
your computer.

Load from File Click this button to load an image saved on your 
computer into the image area. In this way, you can 
insert a saved image into your patient’s record.

The following image formats are supported:

 • bmp

 • jpg

 • tif

 • gif

 • png

Note: The Load from File button will remain active 
after you scan a document from the Multimedia 
Entry screen. Consequently, eMDs recommends 
that you save any scan prior to using the Load 
from File feature/button.

Save button Click this button to save the image in CGM 
MEDISOFT.

 • If you were scanning from the Case-
Multimedia tab, your image will appear on the 
list of images on the Case-Multimedia tab.

 • If you were scanning from a Policy tab, the 
image will appear on the Policy tab. 

Images are only saved to the case once when the 
Case is saved. 

Cancel button Click this button to undo any scan or changes to a 
scanned image and close the screen.

Help button Click this button to open the Help file for this 
screen.

Element Description
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Procedures

Note: the steps may vary depending on your scanner. For some scanners you must place your 
document on the scanner and for others you can “feed” your documents to the scanner.

Scanning from a Policy tab
To scan an insurance card from a Policy tab:

1. In CGM MEDISOFT, open the case and select the appropriate Policy tab.

2. Select either Front card or Back card. 

3. Place the card on the scanner.

4. Click the Scan button. The Multimedia Entry screen opens.

5. Enter any note and select a scanner.

6. Complete the options and click the Scan button. The image will preview in the Viewing area. 

7. Manipulate the image as necessary and click the Save button.

Deleting an image on a Policy tab
To delete a scanned card on a Policy tab:

1. Click the X icon to the right of the front card or back card radio button.

2. Click Yes to confirm.
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Transaction Entry Alerts enable you to have messages appear when you save transactions during 
transaction entry or while posting unprocessed charges from the Edit screen, allowing you to scrub 
the claim immediately while the transaction is still open. You can create message using a variety of 
data in CGM MEDISOFT and have them appear when a transaction is saved. Multiple messages 
can be triggered simultaneously and will all appear in a new popup screen. 

For instance, you may want to alert: 

 • When a certain procedure code is present at the same as another procedure and should not 
be billed together. 

 • When an admin procedure code is missing and should be billed with another transaction on 
the same bill.

Transaction Entry Alert List screen
This screen shows you a list of the Transaction Entry Alerts that have been created.

The table below gives a description of the elements on this screen.

Element Description

Grid Layout button (top left) Click this button to modify the list of fields that 
appear in the List grid. 

This option is available for all versions of CGM 
MEDISOFT, including CGM MEDISOFT Basic.

Search for Enter the information you want to search for. As 
you type, the list will filter.

This search is like all others in CGM MEDISOFT 
and is a ‘Starts with‘ search.

? button Click this button to open the Locate Transaction 
Entry Alert screen, which you can use to perform a 
search. For more information, see “Locate 
Transaction Entry Alert screen” on page 100.

Partial Match check box Select this check box if you want CGM 
MEDISOFT to search for partial matches to the 
item in the Search for box.

This is a ‘Contains’ search which looks for a partial 
match anywhere in the selected field. 
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Field (Procedure Code/Message drop-
down)

Select either Procedure Code or Message to 
specify the type of information you want to search 
for. 

The column header of the field that you select 
here will change to a blue color in the grid column 
header to show you which field is being searched 
in.

Grid The grid area shows you the details of each 
message that has been created. By default, only 
active records appear.

To modify the columns in the grid, click the black 
dot at the top left of the grid. This will open the Grid 
Columns screen.

If multiple items were selected for a criterion, you 
can see them in the columns.

 • You can double-click an item in the grid to 
open the Transaction Entry Alert screen for 
that item.

Edit button Click this button to edit an existing alert. Highlight 
the alert you want to edit and click Edit.

This button will be disabled if no alerts have been 
created or the user does not have Edit permission.

If you attempt to edit an alert at the same time as 
another user, you will receive a notice.

New button Click this button to open the Transaction Entry 
Alert screen, on which you can create a new 
message. For more information, see “Transaction 
Entry Alerts screen” on page 101.

This button will be disabled if the user does not 
have New permission.

Delete button Click this button to delete an existing alert. You will 
see a confirmation screen before the alert is 
deleted.

This button will be disabled if no alerts have been 
created or if the user does not have Delete 
permission.

Element Description
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Right-click menu
There is a right-click menu on the Transaction Entry Alerts List screen that you can use to perform 
actions on a selected item in the list.

Figure 83.  Right-click menu

Print Grid button Click this button to print the grid section of the 
Transaction Entry Messages List screen.

This button will be disabled if no alerts have been 
created.

Important: The fields Diagnosis, Modifier, and 
Other Procedure(s) will appear as either 0 or 1 
when you print the grid, where 0 means Missing 
and 1 means Present.

Tip: as with any report with many columns that 
cannot easily fit on a printed page, you may want 
to print in Landscape format and limit the columns 
to the most important for easier viewing. 

Note: The Permission to print the grid is controlled 
by the Reports/Print Grid permission. 

Import button Click this button to import a set of alerts from 
another practice. When you click the button, the 
Open screen will open. For more information, see 
“Import Alerts” on page 103.

Export button Click this button to export the active alerts to 
another practice. 

When you click the button, the Save As screen will 
open. Enter a name for the file and select a folder 
on the computer where the file will placed.

Note that extension of the file will be *.TEA.

Close button Click this button to close the screen. 

Element Description
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The table below describes the options on this menu.

Locate Transaction Entry Alert screen
This screen will open when you select Locate on the Right-click menu or when you click the ? 
button on the Transaction Entry Alerts List screen. Use this screen to locate a term or information 
in the list of alerts. 

Figure 84.  Locate Transaction Entry Alert screen

The table below describes the elements on this screen.

Option Description

Edit Select this option if you want to edit the selected alert.

New Select this option if you want to create a new alert.

Delete Select this option if you want to delete the selected alert.

Import Select this option to import alerts into your practice.

Export Select this option to export alerts from your practice to a file.

Locate Select this option if you want to locate a term or information in the 
list of alerts. Selecting this option will open the Locate 
Transaction Entry Alert screen, which you can use to locate the 
term. For more information on this screen, see “Locate 
Transaction Entry Alert screen” on page 100.

Show Inactive Records Select this option if you want to see alerts that have been marked 
as Inactive.

Print Grid Select this option if you want to print the list of alerts.

The fields Diagnosisis, Mod(ifier), and Other Procedureis) will 
appear as either 0 or 1 when you print the grid, where 0 means 
Missing and 1 means Present.

Note: The permission to print the grid is controlled by the Reports/
Print Grid permission. 

Element Description

Field Value Enter the value you want to locate in the list.
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Transaction Entry Alerts screen
Use this screen to create or edit alerts. Once you save an alert, it will appear on the Transaction 
Entry Alerts List screen.

Note: if you are using keyboard controls to navigate through the fields on this screen, be sure to 
use the Tab key to advance. If you use the Enter key on any field other than the Message field, it 
will cause the data to be saved and close the screen. 

The table below describes the elements on this screen.

Case-sensitive Select this check box if you want the search to be case-
sensitive.

Exact Match Select this radio button if you want to find an exact match for 
the value entered in the Field Value field.

Partial Match at Beginning Select this radio button if you want to find items that partially 
match the beginning of the value entered in the Field Value 
field.

Partial Match Anywhere Select this radio button if you want to find items that partially 
match anywhere with the value entered in the Field Value field.

Fields Select the field on the List screen that you want the search to 
look for matching items.

First button Click this button to start the search for the first matching value.

Next button Click this button to find subsequent matches.

Cancel Click this button to cancel the search and close the screen.

Element Description

Element Description

Message Use this field to enter the message you want to appear on the 
popup when this alert is triggered.

This is a required field.

Messages appear in the Transaction Entry Alert pop-ups in 
alphabetical order, with numbers and special characters appearing 
first. So, for example, if you want a certain message to always 
appear first in the list of messages, you could place a 1 or an 
asterisk at the beginning of the message. 

Inactive check box Select this check box if you want this alert to be inactive. It will no 
longer appear in the Transaction Entry Alert List screen by default 
and will no longer provide an alert message. 

Insurance Use the Lookup button to select Insurances to trigger a message. 
You can select one or more insurances. 

To clear the Insurance field, click the X icon to the right.
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Insurance Class Use the Lookup button to select Insurance Classes to trigger a 
message. You can select one or more classes. 

To clear the Insurance Class field, click the X icon to the right.

Insurance priority check 
boxes

Select which insurance priorities will apply to this alert.

 • If an insurance carrier or insurance class is selected, at least 
one check box must be selected.

 • If one or more insurance carriers or insurance classes are 
selected AND no priority check box is selected, all three will be 
selected by default.

 • If you clear the insurance carrier and/or insurance class data, 
the check boxes will NOT be cleared automatically.

Facility Use the Lookup button to select Facilities to trigger a message. You 
can select one or more facilities. 

To clear the Facility field, click the X icon to the right.

Assigned Provider Use the Lookup button to select Assigned Providers to trigger a 
message. You can select one or more providers. 

To clear the Assigned Provider field, click the X icon to the right.

Attending Provider Use the Lookup button to select Attending Providers to trigger a 
message. You can select one or more providers. 

To clear the Attending Provider field, click the X icon to the right.

Procedure Code Use the Lookup button to select Procedure Codes to trigger a 
message. You can select one or more codes. 

To clear the Procedure Code field, click the X icon to the right.

You can also type a code or codes into this field.

Modifier Enter any modifiers that you want to trigger a message.

Alert when information 
is all missing/any 
present

Select if you want the alert to be triggered by the presence or 
absence of the modifier. Alerts will trigger is ALL of the items are 
missing or if ANY of the items is present.

Diagnosis Use the Lookup button to select Diagnosis Codes to trigger a 
message. You can select one or more codes. 

To clear the Diagnosis Code field, click the X icon to the right.

Alert when information 
is all missing/any 
present

Select if you want the alert be triggered by the presence or absence 
of the diagnosis code. Alerts will trigger is ALL of the items are 
missing or if ANY of the items is present.

Alert when other 
procedures are missing/
present

Select if you want the alert be triggered by the presence or absence 
of additional procedures codes.

Element Description
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Note: Although there is no multi-select on the fields in this screen, you can select items one at a 
time from list and then repeat as needed, or you can manually type in codes and separate them 
with a comma.

Rules examples:
 • All the fields for the alert rules are AND conditions.  So if you have an Insurance listed as part 

of a rule AND two Procedure codes, your transactions/charges must have BOTH that 
Insurance AND one of the Procedure codes. This is true of all other fields, EXCEPT when both 
Insurance Code and Insurance Class have an entry. In that case, it is an OR condition. That is, 
only ONE of them needs to be part of the transaction/charge. 

 • When entering multiple items in any field where the alert is looking for the codes to be present: 
the alert will appear when ANY of the codes are present. For example, you create an alert with 
the following Procedure codes entered in the upper section of the screen: 
99213,99214,99214,99215. An alert will be triggered if your charges have ANY of these codes.

 • If you enter the following Diagnosis codes in the top section with the All Missing radio button 
selected: E10.8, I73.9. An alert will be triggered only if your charges are missing both (all) of 
these diagnosis codes. If one is present it will not trigger. 

 • When you add something in the Other procedure section at the bottom of the screen, an alert 
will be triggered when your charges meet the criteria in the top section AND this section.

Import Alerts
Use the Open screen to import a set of rules from another practice or computer. When the screen 
opens, search for a file that has the extension *.TEA

Procedure Code Use the Lookup button to select Procedure Codes to trigger a 
message. You can select one or more codes. 

To clear the Procedure Code field, click the X icon to the right.

Modifier Enter any modifiers that will trigger a message.

The Modifier field is enabled only when the ‘present’ radio button is 
selected AND one or more procedures are selected. If a modifier is 
selected and then the radio button is changed to 'missing', the data 
is removed from the field and it is disabled.

Diagnosis Use the Lookup button to select Diagnosis Codes to trigger a 
message. You can select one or more codes. 

To clear the Diagnosis Code field, click the X icon to the right.

The Diagnosis Code field is enabled only when the ‘present’ radio 
button is selected AND one or more procedures are selected. If a 
code is selected and then the radio button is changed to 'missing', 
the data is removed from the field and it is disabled.

Save button Click this button to save the information for this alert.

Cancel button Click this button to discard any changes or new information and 
close the screen.

Help button Click this button to obtain help for this screen.

Element Description
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Select the file to import and click Open.

Note: If you import rules from one practice to another practice that does not contain some of the 
codes selected in a rule, the rule will import but would not fire when entering charges. You will need 
to 'fix' the rule in the new practice. Example. Practice A exported rules that have a rule for CPT 
99213 and Attending provider ABC. Rules are imported to Practice B that does not have provider 
ABC. If the rule applies to Practice B, change the provider code to one that is in this practice or 
remove it to apply to all. 

Transaction Entry Alert pop-up
Alerts will compare transactions with the same Document/Superbill number against the rules. 
When the conditions for a message are met when you are saving a transaction (either a new 
transaction or one that you have added items to, or edited), or posting unprocessed charges, the 
message is triggered and appears on the screen when saved. If multiple messages are met, you 
will see all of them on the message screen.

Figure 85.  Transaction Entry Alert pop-up

The table below describes the elements on this screen.

Element Description

Date column This column shows the date of the transaction/service line from 
Transaction Entry.

Document Number column This column shows the document number/Superbill associated 
with the transaction/service line in Transaction Entry.

Procedure column This column shows the procedure codes associated with the 
message. Multiple codes may appear here. The presence of .... 
indicates that there are more codes than can fit in the column. 
You can widen the column if necessary to see all the codes.
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Note: a hover over will display the entire text of the message when you move the cursor over the 
message line.

Rules
All of the criteria for a rule must be met before a pop-up will appear. 

If multiple rules are met, all of the messages will appear on the same pop-up in alphabetical order

If you add a line item to an existing transaction, the new line item and other line items with the 
same document number will be checked for messages.

For Procedure codes that are assigned for Patient Only Responsible, the alert will not appear if that 
procedure code is part of the alert and there is an Insurance Code or Class.

Tip: if you want alerts to appear for patient responsible amounts, leave the Insurance Class and 
Code fields empty. 

Regarding Diagnosis codes, CPT Modifiers, and Other Procedure:

 • If the Diagnosis or Modifier is set for “Any Present” and there are multiple values in the alert, 
then just one needs to be present

 • If the Diagnosis or Modifier is set for “All Missing” and there are multiple values in the alert, 
then ALL values need to be missing.

If you are not displaying Document Number or Superbill number at the top of Transaction entry, this 
feature will still work since each transaction is assigned a document number in the database.  You 
may want to add the Document number field to the charges grid to more easily see which 
transactions are tied to the same document number.

Warning Message column This column displays the text of the message that was 
activated. Messages will appear in alphabetical order based on 
the first letter of the message.

Memo field This field shows you the selected message in full. 

Yes button Click Yes to continue saving the transaction.

No button Click No to return to the Enter Transactions screen so you can 
make changes. 

Element Description
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Use the Transaction Entry screen to enter charges for procedures performed on patients. You can 
also enter co-payments here or adjustments to the patient’s bill. When you open the screen and 
select a Chart (patient) and case number, CGM MEDISOFT automatically collects information 
from the patient and case records and displays it in the screen. The top right section of the screen 
shows you the patient’s balance, insurance information, and aging.

CGM MEDISOFT is an Open Item Accounting program, meaning that transactions entered are 
marked when paid but remain on the active ledger as long as the case is active. There is no 
clearing of the ledger and bringing up a total to start a new month, as with a balance forward 
program.  

To open Transaction Entry:
1. On the Activities menu, click Enter Transactions. The Transaction Entry screen appears.
2. Select or enter a Chart (patient). The screen fills with patient information, including a Case 

number.

You can choose a default for the case number that appears on the Data Entry tab in Program 
Options. 

3. If necessary, change the case number.
4. To add a new charge, click the New button in the Charges section of the screen.
5. Select a Procedure and complete the remainder of the fields on the new charge line. Some of 

the information will be filled in automatically. 
6. Enter further charge lines as necessary.
7. If you need to enter a patient’s co-payment or other payments/adjustments, click the New 

button in the Payments, Adjustments, and Comments section of the screen.
8. Select a Pay/Adj Code and complete the line. 
9. To apply this payment to a charge, click the Apply button. The Apply Payment to Charges 

screen appears. 
10. Click in the This Payment check box and enter the amount to be applied. 

Option: Use the Apply to CoPay or Apply to Oldest buttons to automatically apply the payment.

11. Click the Close button. Note that the Unapplied amount on the payment line changes. 

WARNING: eMDs recommends that you apply all payments and adjustments to charges.  Failure 
to do so results in other parts of CGM MEDISOFT not functioning properly, i.e., remainder billing 
and the delay secondary billing feature (Advanced and CGM MEDISOFT Network Professional), to 
name only two. In addition, some report results will be incomplete or inaccurate.

12. Click the Tax button if you need to add sales tax to the charges.
13. Click the Note button if you need to add further detail for a charge line. This may include detail 

for claims. 
14. Click the Save Transactions button.
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Unprocessed Transactions 

The Unprocessed Charges screen provides an interface between an Electronic Medical Records 
(EMR) service and CGM MEDISOFT via McKesson Practice Interface Center (see “McKesson 
Practice Interface Center (MPIC)” on page 189) or a mobile device (CGM MEDISOFT Network 
Professional only). Transactions that come from the EMR appear here in an unposted state. As 
long as they are unposted, they will not be part of patient accounts and you cannot file claims on 
them or bill patients for them. 

To open this screen:
1. On the Activities menu, point to Unprocessed Transactions and click Unprocessed EMR 

Charges. The Unprocessed Charges screen appears with a list of transactions that have yet 
to be posted.

Figure 86.  Unprocessed Charges screen

If there is a red or yellow x in the Transaction Status column for a line, click the Edit button to 
open the details and see the problem with the transaction. A red x indicates an error with the 
transaction that will likely cause it to fail claim scrubbing. A yellow x indicates a warning, such 
as a mismatch in an ICD code set version. 

Any notes associated with a transaction, usually coming from a mobile device, will appear as 
an icon in the unlabeled column. 

2. Select the check boxes in the Post column for the transactions you want to post.
3. Click the Post buton to update your patients’ accounts. 
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In this chapter you will learn about the Quick Ledger and Quick Balance features in CGM 
MEDISOFT. 

Quick Ledger

NOTE: This is an Advanced and CGM MEDISOFT Network Professional feature.

The Quick Ledger gives a quick reference for transaction and other information in the patient’s 
account. There are two types of Quick Ledgers in CGM MEDISOFT: the Patient Ledger and the 
Guarantor Ledger.  

The Patient/Quick Ledger displays transaction information and account totals for individual 
patients. The Patient Ledger is the default ledger.

Figure 87.  Quick Ledger screen

To open the Patient Ledger:
 • On the Activities menu, click Patient Ledger.

The Guarantor Ledger provides the same information as the Patient Ledger but allows you to view 
guarantor totals as well. 

To get quick and easy access to a patient’s ledger from almost anywhere in CGM MEDISOFT, 
press F7 or click the Quick Ledger speed button.  

To open the Guarantor Ledger:
 • On the Activities menu, click Guarantor Ledger.



CGM MEDISOFT 27
110 27 December 2022

Quick Balance Chapter 19 - Quick Ledger and Quick Balance

While no new transactions can be made in the ledger itself, you can edit and print the ledger and 
gain valuable detail on patient accounts.

You can change responsibility for a selected transaction in the Quick Ledger screen. Right-click a 
transaction to change its responsibility between insurance carriers or from an insurance to the 
patient. This feature lets you skip entering the zero-dollar insurance payment to indicate that no 
payment is coming from the insurance carrier. 

Click the Edit button or press F9 to open the Transaction Entry screen where charges, payments, 
and adjustments can be reviewed and edited, as needed. Both the Patient and the Guarantor 
Ledgers let you view the notes entered for transactions and also add a note. 
Click the Payment Detail button to display all payments/adjustments made toward a specific 
charge. 

TIP: If you click the Quick Statement button, you will print statements from the Reports menu. If 
you click Statement, you will print statements from Statement Management.  For more information 
in creating and printing statements, see “Creating Statements” on page 121.

 

Quick Balance 

NOTE: This is an Advanced and CGM MEDISOFT Network Professional feature.

The Quick Balance is a summary of all remainder charge totals for a selected guarantor record.  

To open the Quick Balance screen:
 • On the Activities menu, click Quick Balance. 

Figure 88.  Quick Balance screen

If the record selected is a guarantor’s record, the Quick Balance screen displays each patient for 
whom the guarantor is responsible and the total qualifying remainder charges for each. If the 
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record selected is not a guarantor’s record, you will see a listing of all the selected patient’s 
balances. 

TIP: If you click the Print button in Quick Balance, you will print statements from the Reports 
menu. For more information in creating and printing statements, see “Creating Statements” on 
page 121.



CGM MEDISOFT 27
112 27 December 2022

Quick Balance Chapter 19 - Quick Ledger and Quick Balance



CGM MEDISOFT 27
December 2022 27  113

Chapter 20 - Creating Claims

In the chapter you will learn how to create claims in CGM MEDISOFT. 

Claim Management

This section explains briefly how to manage claims in CGM MEDISOFT and includes creating, 
editing, printing/reprinting, and listing claims, as well as changing claim status. 

The Claim Manager’s Job 
To help you better understand the function of claim management, consider this shipping analogy.  
Whereas Cases are containers filled with claims for specific diagnoses, claim management is the 
process by which the cases are checked, sorted, and delivered. In other words, claim management 
is the process of making sure all shipments are correct, ready to be sent, and shipped to the right 
companies (insurance carriers).  

The Claim Manager (the person performing claim management) checks the claims, makes sure 
the boxes are properly marked, and sends them on their way. The Claim Manager determines 
whether the shipment goes by truck (paper claims) or by air (electronic claims). When a box is 
returned (rejected claim), the Claim Manager makes whatever changes are necessary (with help 
from the EOB or Audit/Edit Report) and ships the box again (resubmits the claim).

One person sees and treats the patients; another person enters data from the superbill (see 
“Superbill” on page 190) to begin the billing process. Once all the data has been entered, it must 
go through the Claim Manager’s office before being sent to an insurance carrier.

The Claim Manager focuses on three principal areas, not necessarily sequential:  review, batch, 
and final review.

 • Watchdog:  The Claim Manager is, first of all, the watchdog of the claims. The Claim Manager 
checks each claim and verifies the numbers, having the authority to edit the claim and make 
needed changes. If there is something in the claim that should go to a different carrier than 
indicated, or if the EDI receiver information is incomplete, the Claim Manager corrects the 
record. The Claim Manager also has access to the insurance carrier records and checks the 
billing date and how the claim is to be sent, either by paper or electronically. Then, the Claim 
Manager can indicate the status of the claim.  

 • Batch ‘em up!  The function of creating claims serves to group claims that are headed to the 
same destination. The Claim Manager gathers and sorts by range of dates or chart 
numbers. Transactions can be selected that match by primary carrier, Billing Code, case 
indicator, or location. Random Billing Code numbers can be selected. The Claim Manager can 
also indicate a minimum dollar amount for creating the claims, eliminating claims too small to 
be worth billing.

 • Reviewer:  There is also a List Only button that allows the Claim Manager to retrieve claims 
that match certain criteria that have been determined. The List Only Claims That Match 
screen is a “show me” screen that lets the Claim Manager review all that is in CGM 
MEDISOFT.  
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Besides these three focus areas, the Claim Manager also has responsibility to mark claims that are 
paid and those that are rejected.

 • Marking paid claims: The date of submission in the Claim Management screen indicates when 
the claims were shipped or transmitted. Claims are marked under the designation of “Sent” 
and the date is automatically inserted. The claims stay in Claim Management marked as 
“Sent” until they are manually changed in the Claim edit screen as having been received and 
dispatched by the carrier. When a payment is received, use the EOB to enter all payments 
through transaction entry. 

 • Handling rejected claims:  When a paper claim is rejected for payment by the insurance 
carrier, the Claim Manager can change the payment status in the Claim Management screen 
from “Sent” to “Rejected.”   

Creating Claims
To perform claim management functions, use the Claim Management screen. Here is where you 
create, edit, and print claims. Claims that will be sent electronically are created here but sent with 
Revenue Management, an integrated application that will send claims and receive payments. For 
more information on Revenue Management, see “Electronic Claims Processing” on page 145.

To create claims:
1. On the Activities menu, click Claim Management. The Claim Management screen appears.

Figure 89.  Claim Management screen

2. Click the Create Claims button. The Create Claims screen appears.
3. Use the fields on this screen to filter the ranges of dates, chart numbers, insurance carriers, 

and so on. 
4. Click the Create button. The Claim Management screen appears and displays the claims that 

were created.

Editing Claims
If a claim is rejected by the carrier, you will have to edit it so that it contains all of the information 
that the carrier wants. 

To edit a claim:
1. On the Activities menu, click Claim Management. The Claim Management screen appears. 
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2. Highlight the claim you want to edit and click the Edit button. The Claim screen appears with 
the claim detail.

Figure 90.  Claim screen

The Claim screen has several tabs that contain the information for the claim. 

3. Revise the information on the tabs as necessary. 
4. Click the Save button. 

Printing Claims
If you print and send paper claims to clearinghouses and carriers, use the printing feature on the 
Claims Management screen.

1. On the Activities menu, click Claim Management. The Claim Management screen appears.
2. Click the Print/Send button. The Print/Send Claims screen appears.

Tab Description

Carrier 1, 2, 3 Use this tab to change the Claim Status, Billing Method, and the 
insurance carrier or EDI Receiver.

Transactions Use this tab to see all of the transactions that are part of the 
selected claim. You can split, add, or remove transactions here.

Comment Use this tab to place whatever comments you feel are necessary 
concerning this claim and/or any transactions relating to it. If you 
have CGM MEDISOFT Advanced or CGM MEDISOFT Network 
Professional, these notes will appear as a note icon in the Claim 
Management screen.

EDI Note Use this tab to add information for EDI notes.
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3. Select Paper and click the OK button. The Open Report screen appears.

Figure 91.  Open Report screen

4. Select which form you want to print on and click the OK button. The Print Report Where? 
screen appears.

Figure 92.  Print Report Where? screen
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5. Select your option and click the Start button. The Data Selection Questions screen appears.

Figure 93.  Data Selection Questions screen

6. Make your selections for the various ranges and click the OK button. 
7. The Status of the claims will be updated to Sent on the Claim Management screen. 

Troubleshooting Insurance Claims

Claim Form Not Centered
If your insurance claims are printing off-center, you can fix this with the following steps:

1. On the Reports menu, click Design Custom Reports and Bills. The CGM MEDISOFT 
Report Designer opens.
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2. On the File menu of CGM MEDISOFT Reports Designer, click Open. The Open Report 
screen appears.

Figure 94.  Open Report screen

3. Select the report form you use and click the OK button. The form opens.
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4. On the File menu, click Report Properties. The Report Properties screen appears.

Figure 95.  Report Properties screen

5. In the Form Offset section of the screen, adjust the form as necessary from the top and/or left 
margins. The form is moved in increments of one hundredth of an inch. 

6. Click the OK button.
7. Save the report and close CGM MEDISOFT Reports Designer.

Reprinting Claims
You can reprint claims if there is a problem with some of those that printed. To do so, follow the 
steps above on printing claims, except select Reprint Claim instead of Print/Send. See “Printing 
Claims” on page 115.

Changing Claim Status
In the Claim Management screen, all submitted claims are automatically marked Sent with an 
indication of the method of submission. There may be occasions when you need to change this 
status, for instance, if you need to resend them from Revenue Management. 

Entire Batch
If the status of an entire batch needs to be changed, you can change all the claims at once.  
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1. Highlight one of the claims on the Claim Management screen and note the number listed in 
the Batch 1 column.  

2. Click Change Status. The Change Claim Status/Billing Method screen appears.  

Figure 96.  Change Claim Status/Billing Method screen

3. Select Batch and enter the batch number from the Batch 1 column in the Claim Management 
screen.  

4. Choose the appropriate buttons in the Status From and Status To sections.  
5. Click the OK button.   

Selecting Multiple Claims
1. When only one or a few claims within the same batch or claims from multiple batches need a 

status change, on the Claim Management screen, hold down the CTRL key and click each 
claim that needs the status changed. Note that the selected claims do not need to have the 
same claim status, but they will all change to the same status when you complete this 
procedure.  

2. Click the Edit button. 
3. In the Change Claim Status/Billing Method screen, click Selected Claim(s)
4. Select the appropriate buttons in the Status From and Status To sections. 
5. If you have chosen claims with varying statuses, select Any status type in the Status From 

section.  
6. Click the OK button.  
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In this chapter you will learn how to create statements for billing your patients and updating them 
on charges to their accounts.

Statement Management 

NOTE: This is an Advanced and CGM MEDISOFT Network Professional feature.

This section explains briefly how to manage statements within the Statement Management screen 
and includes creating, editing, printing/reprinting, and listing statements, as well as changing 
statement status.

You can use Statement Management to create, bill, and rebill statements all from one place.  You 
can also view information about the statement, such as the guarantor, the status, the initial billing 
date, and the type. You can also generate statements to track missed copays. 

Creating Statements
When you want to bill your patients, create statements. You can print your statements to paper or 
you can use BillFlash to send them electronically. BillFlash will print and send your statements to 
your patients for you. 

1. On the Activities menu, click Statement Management. The Statement Management screen 
appears. For more information on BillFlash, see “BillFlash Users” on page 37.

Figure 97.  Statement Management screen

2. Click Create Statements.  
3. Enter ranges of transaction dates and/or chart numbers to control which statements are 

created, as well as other data for filtering the data.  
4. Click the Create button. The system tells you how many statements were created. 
5. Click the OK button. The new statements appear on the Statement Management screen.
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Editing Statements
1. On the Statement Management screen, highlight a specific statement.
2. Click the Edit button. You can modify general statement information, the transactions that 

appear on the statement, and any comments attached to the statement. When you make 
changes in the Statement edit screen, you modify only that statement and do not affect the 
defaults for other statements. 

Figure 98.  Statement screen

The Statement screen has three tabs that contain the information for the claim. 

3. Revise the information on the tabs as necessary. 
4. Click the Save button. 

Printing Statements
If you print and send paper statements to your patients, use the printing feature on the Statement 
Management screen.

1. On the Activities menu, click Statement Management. The Statement Management screen 
appears.

Tab Description

General Use this tab to change the Claim Status, Billing Method, and the 
billing date.

Transactions Use this tab to see all of the transactions that are part of the 
selected statement. You can split, add, or remove transactions 
here.

Comment Use this tab to place whatever comments you feel are necessary 
concerning this statement and/or any transactions relating to it. 



CGM MEDISOFT 27
December 2022 27 123

Chapter 21 - Creating Statements Printing Statements

2. Click the Print/Send button. The Print/Send Statements screen appears.

Figure 99.  Print/Send Statements screen

3. Select Paper and click the OK button. The Open Report screen appears.

Figure 100.  Open Report screen
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4. Select which form you want to print and click the OK button. The Print Report Where? screen 
appears.

Figure 101.  Print Report Where? screen

5. Select your option and click the Start button. The Data Selection Questions screen appears.

Figure 102.  Data Selection Questions screen

6. Make your selections for the various ranges and click the OK button. 
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7. The Status of the claims will be updated to Sent on the Statement Management screen. 

Reprinting Statements
If necessary, you can reprint statements without regard to their status. To reprint an entire batch, 
the status must be changed for the batch.

Changing Statement Status
In the Statement Management screen, all submitted statements are automatically marked Sent 
with an indication of the method of submission. There may be occasions when you need to change 
this status.  

Statements sent electronically through BillFlash get a report that marks each statement as either 
accepted or rejected.  

Entire Batch
If you need to change the status of an entire batch, you can change all the statements at once. 

1. On the Statement Management screen, highlight one of the statements and note the number 
listed in the Batch column. 

2. Click Change Status. The Change Statement Status/Billing Method screen appears. 

Figure 103.  Change Statement Status/Billing Method screen

3. Select the Batch button and enter the batch number from the Batch column in the Statement 
Management screen.  

4. Select the appropriate buttons in the Status From and Status To sections. 
5. Click the OK button.  

Selecting Multiple Statements
1. When only one or a few statements within the same batch or statements from multiple batches 

need a status change, on the Statement Management screen hold down the CTRL key and 
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click each statement that needs the status changed. Note that the selected statements do not 
need to have the same status, but they will all be changed to the same status.  

2. Click the Edit button. The Change Statement Status/Billing Method screen appears.
3. Select Selected Statement(s).
4. Select the appropriate buttons in the Status From and Status To sections. 
5. If you have chosen statements with varying statuses, choose Any Status Type in the Status 

From section.  
6. Click the OK button.  

Billing Cycles
The cycle billing feature lets you print statements every certain number of days. If you want to print 
statements every 30 days, you can set up a billing cycle of that length.  

Follow these steps to set up a billing cycle:

1. On the File menu, click Program Options. The Program Options screen appears.
2. Select the Billing tab.
3. Select the Use Cycle Billing check box.

Figure 104.  Program Options screen - Billing tab

4. Enter a number in Cycle Billing Days. The number of days indicates the length of your billing 
cycle. 

5. Click the Save button.
Now, after you click Print/Send on the Statement Management screen, CGM MEDISOFT will 
automatically print statements based on the Next Statement Date of each statement. If the Next 
Statement Date is on or before the current date, the statement prints. If you have never printed 
statements with the billing cycle turned on, statements are printed according to the Last Statement 
Date stored in the statement record. If the Last Billing Date plus the billing cycle interval is on or 
before the current date, the statement prints. 
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NOTE: Statements might not print if they are filtered out by report selection questions or by 
predefined statement processing rules.

The program updates the statement's Next Statement Date for the next time you process 
statements.

Troubleshooting Statement Printing

Patient Remainder Statements 

NOTE: This is an Advanced and CGM MEDISOFT Network Professional feature.

If you are having trouble printing patient remainder statements, check to be sure the following items 
have been performed:

 • The patient has insurance coverage. This is indicated in the patient Case screen, Policy 1 tab, 
Insurance 1 field (also Policy 2 and Policy 3 tabs if there is secondary and/or tertiary 
coverage).

 • A charge has been posted in the patient case.
 • A claim has been created.
 • An insurance payment or adjustment has been posted, applied, and marked as Complete to 

the account for each applicable carrier. 
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NOTE: Deposits/Payments is an Advanced and CGM MEDISOFT Network Professional feature.

Although you can enter payments in transaction entry for patient copays, you can also enter 
payments using Deposit/Payment. This option makes creating a deposit list and applying 
payments, especially payments from insurance carriers, an easy process. The advantage to this 
option is that you can apply a payment toward several cases and charges from the same screen. 

Entering a Payment

To enter a payment:
1. On the Activities menu, click Enter Deposits/Payments. The Deposit List screen appears.  

Figure 105.  Deposit List screen

2. Click the New button. The Deposit (new) screen appears.
3. Select the appropriate Payor Type. Depending on your selection, the fields on the screen will 

change. 
4. Complete the remaining fields as necessary, specifying the insurance or patient who paid.
5. Click the Save button. The new payment appears on the Deposit List screen and is 

highlighted. It is now available to be applied to charges. 

Applying a Payment
1. On the Activities menu, click Enter Deposits/Payments. The Deposit List screen appears.

TIP: To save time and increase work efficiency, you can close a case after applying payment by 
right-clicking the line item in the grid and then selecting Close Case.  
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2. Highlight a payment and click the Apply button. The Apply Payment/Adjustments to Charges 
screen appears.

3. Select the patient chart number (if you have chosen an insurance payment)
4. Apply the portion of the payment to the applicable charge(s). 
5. Click the Save Payments/Adjustments button.  

TIP: If you select the Print Statement Now check box and click the Save Payments/Adjustments 
button, you can print statements from Statement Management.

6. If you need to apply payments from the same deposit to another patient record, select the next 
patient chart number and continue making payment applications. 
This screen is also tied to the Payment Application tab of Program Options. Unless 
deactivated, all payment applications are automatically checked as paid in full by the payer, 
allowed amounts are calculated on all charges, and any charges over the calculated allowed 
amounts are automatically entered in the Adjustment field. You can open and change Program 
Options that are applicable to this screen by clicking Options in the bottom left of the screen

TIP: Be sure to click the Save Payments/Adjustments button before closing this screen or 
transactions cannot be created. 

7. Click the Close button.

EOB Payments

Part of the payment structure to a healthcare office from an insurance carrier involves a check and 
an Explanation of Benefits. Widely known throughout the industry as the EOB, it lists claims for 
which payment is being made and, in some cases, an explanation of what is not being paid and 
why.

Not every insurance claim that is filed with a carrier is paid in full. It may be that payment is 80 
percent of the claim or it may be 50 percent. Other times a claim may be totally or partially 
disallowed. The EOB explains in these cases. Normally, the part that is not paid by the carrier is 
picked up by a secondary carrier or charged back to the patient.

When a payment is received, a transaction must be entered to offset the charges. This is done by 
creating a deposit in the Deposit List screen. If the payment covers several charges, distributing a 
payment to specific charges can be handled by clicking Apply.  Then, select the patient records 
and claims to be paid and designate how much goes to each.  

Managed Care

One of the important sources of patients and income in many practices are managed care 
organizations. An HMO or PPO provides a list of patients who have selected your practice as their 
primary care provider. Payment is made to your practice on a per-patient basis, regardless of 
whether the patient ever visits the office. When a patient does come in for treatment, he or she 
pays a set co-pay amount.
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The co-pay is charged only by the primary care facility or the facility to which the patient is referred 
by the primary care facility. After a patient’s visit to the physician’s office, a claim is filed and sent to 
the carrier. When the EOB is returned, there is seldom a payment included, since payment is made 
under the capitation program for managed care organizations.   

Capitation Payment
The basis for capitation payments is to provide healthcare for a fixed cost, irrespective of the 
amount of service required by each individual patient. This is done in connection with the managed 
healthcare services such as HMOs and PPOs. There is no direct relationship between the 
capitation payment received by the practice and the number of patients covered by the plan who 
actually visit the practice for treatment. Capitation payments are not posted to patient accounts but 
are entered in the Deposit List screen.  If it is necessary to zero out a patient account, create a zero 
deposit for the carrier. For each patient covered by the capitation payment who has an outstanding 
balance, zero out the account by entering the remainder in the Adjustment field. When it is applied, 
the payment shows as zero and the patient’s balance shows as a write off in the Adjustment field in 
the Transaction Entry screen.

ePayments

If you have enrolled with BillFlash and patients are making payments online directly to BillFlash, 
you can download these payments to your practice by clicking ePay on the Deposit List screen. 
CGM MEDISOFT will capture these payments and display them in the Deposit List screen. Then, 
you can apply them to charges. 
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AR Tracker ties together AR management into one cohesive workflow. arn advance filtering to track 
and collect Insurance and patient balances.

This is the main screen for the AR Tracker feature. It displays the filter settings, and the grid shows 
you the information that meets the filter settings.

Figure 106.  AR Tracker screen

When you select AR Tracker for the first time, it displays the default filter selections of All. In 
addition, you can save filter selections and settings on the AR Tracker Filters screen.

Sorting grid columns
You can sort the grid information by a certain column simply by clicking the column header. An icon 
will appear, showing you which column the data is sorted by and whether the sorting is ascending 
or descending. 

Changing grid columns
You can change which columns appear on the grid. To do so, click the black dot at the left of the 
column headers. This will open the Grid Columns screen.

Use the buttons to add or remove fields and click the OK button when you are done.

Filter detail
Below the filter link is the filter detail, which shows you how the grid information has been filtered.

Figure 107.  Filter detail

Drilling down
You can drill down to several levels using the four tabs in the lower top section. 

Figure 108.  Drill-down tabs

The level will appear indented after you select it. 

Double-clicking a grid item will change the level to the right in the list of tabs. You will see that 
change of level in the indented tab. The benefit of double-clicking is that new level will show you 
only the items that pertain to the line item you double-clicked. 
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For instance, double-clicking on Melvin Morris in the image below will show you the Insurance level 
for only Melvin Morris.

Figure 109.  AR Tracker - Provider level

Once you double-click, you will see the image below. Note that the insurance is only for Melvin 
Morris and the Provider Level filter link shows you the provider’s code, indicating the list is filtered 
by that provider.

Figure 110.  AR Tracker - Insurance level filtered by provider

Claims drill-down
When you select the Claims tab and select a line item, the detail for the line item will appear in a 
second grid below.

Figure 111.  AR Tracker with claim detail
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Viewing transactions not assigned to claims
If you want the AR Tracker to show you transactions that have not yet been added to a claim, select 
the No Claim check box on the AR Tracker Filters screen.

Figure 112.  AR Tracker Filter screen

These claims will then appear in the grid and the Claim Number will be NONE.

Figure 113.  AR Tracker screen

AR Tracker Filters screen
Use this screen to set up and save filtering options for your AR tracking.

To open this screen, click the link in the top section of the AR Tracker screen.

Figure 114.  AR Tracker Filters screen
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The table below describes the fields and options on this screen.

Element Description

Existing Filters Use this field to select an existing filter. 

This field will be disabled until you have saved a 
filter.

Save button Click this button to save the filter. You will see the 
Save AR Filter screen on which you can enter a 
name for your new filter.

Delete button Click this button to delete the existing filter.

Aging Type Select Insurance or patient. Depending on your 
selection, the options on the screen will change.

Insurance check boxes Select which insurances you want to include. You 
can select as many as you want. 

Selecting No Claim will enable you to see 
transactions that have not yet been assigned to a 
claim. These items will appear on the grid with a 
Claim Number of NONE.

Note: if you de-select all of the values, the filter will 
run the Primary insurance by default.

Statement Type Select either Remainder or Statement for this field.

This field will not appear when you select 
Insurance for the Aging Type.

Starting Level Select the starting level for the filter. 

AR Status Select an AR Status for this filter.

Aging Range Select the aging range that you want to see.

Insurance Type Select an Insurance Type for this filter.

This field will not appear when you select Patient 
for Aging Type.

Patient AR Status Select an AR Status for the patient.

Assignment Status Select one of the assignment statuses.

AR Task Select an AR Task for this filter. 

Assigned to Use the drop-down to assign a a user to the task.

Task Due Date Range Enter a range in these two fields for due date.

Over Due check box Select this check box if you want overdue tasks to 
appear. 

Date of Service From Select a beginning date for this filter. 

Date of Service To Select an end date for this filter.
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Date Created From Select a beginning date for creating the claim.

Date Created To Select an ending date for creating the claim.

Last Bill Date From Select a beginning last billed date for this filter.

Last Bill Date To Select an ending last billed date for this filter.

Total Amount Due Enter a total amount due range in the two fields.

Insurance Use this field to select which insurance you want to 
include.

 • Click the green Plus icon to include or exclude 
this filter. When the filter is excluded, the Plus 
icon will appear gray.

 • Click the red X icon to clear the field.

This field will be disabled when you select Patient 
for Aging Type.

Insurance Class Use this field to select which insurance class you 
want to include.

 • Click the green Plus icon to include or exclude 
this filter. When the filter is excluded, the Plus 
icon will appear gray.

 • Click the red X icon to clear the field.

This field will be disabled when you select patient 
for Aging Type.

Patient Use this field to select which patients you want to 
include.

 • Click the green Plus icon to include or exclude 
this filter. When the filter is excluded, the Plus 
icon will appear gray.

 • Click the red X icon to clear the field.

Guarantor Use this field to select which guarantors you want 
to include.

 • Click the green Plus icon to include or exclude 
this filter. When the filter is excluded, the Plus 
icon will appear gray.

 • Click the red X icon to clear the field.

This field will be disabled when you select 
Insurance for Aging Type.

Element Description
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Patient Billing Code Use this field to select which Billing Codes you 
want to include.

 • Click the green Plus icon to include or exclude 
this filter. When the filter is excluded, the Plus 
icon will appear gray.

 • Click the red X icon to clear the field.

Case Billing Code Use this field to select which Billing Codes you 
want to include.

 • Click the green Plus icon to include or exclude 
this filter. When the filter is excluded, the Plus 
icon will appear gray.

 • Click the red X icon to clear the field.

Procedure Code Use this field to select which Procedure Codes you 
want to include.

 • Click the green Plus icon to include or exclude 
this filter. When the filter is excluded, the Plus 
icon will appear gray.

 • Click the red X icon to clear the field.

Diagnosis Use this field to select which Diagnosis Codes you 
want to include.

 • Click the green Plus icon to include or exclude 
this filter. When the filter is excluded, the Plus 
icon will appear gray.

 • Click the red X icon to clear the field.

Rendering Provider Use this field to select which Rendering Providers 
you want to include.

 • Click the green Plus icon to include or exclude 
this filter. When the filter is excluded, the Plus 
icon will appear gray.

 • Click the red X icon to clear the field.

Facility Use this field to select which facilities you want to 
include.

 • Click the green Plus icon to include or exclude 
this filter. When the filter is excluded, the Plus 
icon will appear gray.

 • Click the red X icon to clear the field.

Apply button Click this button to apply the filter. The results will 
appear in the AR Tracker screen.

Clear button Click this button to clear the screen and create a 
new filter.

Help button Click this button to open the online Help.

Element Description
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Workflow
To use the AR Tracker feature:

1. Select AR Tracker from the Activities menu. The AR Tracker screen opens.

2. Click the link in the top section to open the AR Tracker Filters screen. 

3. Select an existing filter or click Clear to create a new filter.

4. Make your selections for filtering information. You can save your settings by clicking Save.

5. Click Apply to run the filter. The results will appear in the AR Tracker screen.

AR Tracker field detail
The table below describes the fields and options on the AR Tracker screen.

Right-click menu
When you right-click on a grid line on the AR Tracker screen, this menu appears. The options are 
described in the table below:

Figure 115.  Right-click menu

Close button Click this button to close the screen.

Element Description

Element Description

Current filter link This link shows you the current filter being used. 
Click this link to open the AR Tracker Filters 
screen.

Filter level tabs These four tabs allow you to drill-down to different 
levels of detail. 

The currently-displayed tab appears indented.

Grid section

The information on the grid will vary depending on your filter selections.

Use the grid to collect the information you need for collecting bills. You can drill down to different 
tabs by either clicking the tabs or double-clicking a line item in the grid.

Footer section The footer at the bottom of the screen gives you 
totals for each column.
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The available options will depend on which level is in view.

Option Description

Select All Click this to select all items on the grid.

UnSelect All Click this to clear all items on the grid.

Add AR Note to Claim/Statement Click this option to open the AR Note screen, on 
which you can add a note to the AR Management 
Status screen. 

Note that you can select more than one claim or 
statement and add the AR Note to them 
simultaneously by holding the Shift key (for a 
range of claims/statements) or Ctrl key (for non-
contiguous claims/statements) and selecting this 
option.

AR Task (for all selected) You have two options on the sub-menu:

 • Assign Task: Click to open a screen on which 
you can assign a task to the claim or 
statement.

 • Remove Task: Click this option to remove 
tasks from an insurance or statement.

Note that you can select more than one claim or 
statement and add the AR Task to them 
simultaneously by holding the Shift key (for a 
range of claims/statements) or Ctrl key (for non-
contiguous claims/statements) and selecting this 
option.
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After you select an option, the information on the AR Tracker will refresh automatically. 

AR Status (for all selected) You have four options on the sub-menu:

 • Assign Claim/Statement AR Status: Click to 
assign the claim or statement an AR status 
using the Assign AR Status screen.

 • Assign Patient/Claim AR Status: Click this 
option to assign an AR status to a patient 
using the Assign AR Status screen.

 • Remove Claim/Statement AR Status: Click 
this option to remove the claim or statement 
AR status.

 • Remove Patient/Claim AR Status: Click this 
option to remove the patient or claim AR 
status. 

Note that you can select more than one claim or 
statement and add the AR Status to them 
simultaneously by holding the Shift key (for a 
range of claims/statements) or Ctrl key (for non-
contiguous claims/statements) and selecting this 
option.

Open Patient There are two options on the sub-menu:

 • Open Patient: Click to open the patient’s 
record in the Patient/Guarantor screen.

 • Open Insurance: Click to open the insurance 
record in the Insurance Carrier screen.

Export Grid Data Select this option to export the data in the grid to a 
file that you can move to another computer.

Option Description
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In this chapter you will learn about writing off balances that you know will never be paid. 

 Small Balance Write-off
This feature lets you automatically write off remainder balances of a certain amount. The balance 
written off is the patient remainder balance. You can write off small remainder balances as a batch 
in the Small Balance Write-off screen or for one patient at a time in the Apply Charges/Adjustments 
to Payments screen. 

Writing off a Balance
1. On the Activities menu, click Small Balances Write-off. The Small Balance Write-off screen 

appears.

Figure 116.  Small Balance Write-off screen

2. In the lefthand section of the screen, enter criteria for the type of remainder balances you want 
to write-off and click the Apply button. In the right hand section, a list of the patients who meet 
the criteria appears in the Write-off Preview List. The default is set to write off all records in the 
list. You can select individual records to write off by clicking on the record. Multiple records can 
be selected by pressing the CTRL key and clicking the record. 

3. Click Write off to write off the selected remainder balances.
Use the Stmt Submission Count + field to define a maximum amount of times that you want to 
send a statement before writing off the balance. Once this number is met, the small balance is 
written off. CGM MEDISOFT selects patients whose statements have been sent (submission 
count) more than the value entered in the field. Once this number is met, the small balance is 
written off. This field works in conjunction with the other fields on this screen. If a value is entered in 
this field, the balance is only written off if it meets the criteria for this field (completed the 
statements) and the other fields such as Maximum Amount field. For instance, if you enter 3 in this 
field and 10 in the Maximum Amount field, small balances would be written off after three 
statements are sent and if the balance is under $10.00.
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When CGM MEDISOFT writes off the remainder balances, it updates a number of other areas of 
the database. Write-off entries are created and applied to all patient responsible charges 
associated with the selected patient. CGM MEDISOFT also updates the associated Collection List 
items, refreshing balances and marking zero balances as deleted. After a remainder balance write 
off, statements are changed to the status of Done and a note is added to the write-off entries.
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This chapter gives a brief overview of the electronic services available in CGM MEDISOFT.

Electronic Claims Processing

Electronic claims send your insurance claims online either directly to the insurance carrier or to a 
clearinghouse, which then sends the claims to the insurance carrier. CGM MEDISOFT currently 
ships with Revenue Management, an integrated component that installed when you installed CGM 
MEDISOFT. To launch Revenue Management

 • On the Activities menu, point to Revenue Management, and click Revenue Management.

Statement Processing

You can send statements electronically through BillFlash, the web-based company that is set up to 
process CGM MEDISOFT electronic statements. Statements sent electronically through BillFlash 
get an instant response report that tells what information was sent. BillFlash will receive your 
statement data and then print and send statements to your patients. BillFlash can also receive 
payments from patients and you can download them to CGM MEDISOFT and apply them to 
patient accounts. 

Eligibility Verification

The Eligibility Verification feature lets you check a patient's insurance coverage online. Revenue 
Management conducts eligibility verification behind the scenes.  

Eligibility Verification Setup
Before you can perform eligibility requests electronically, you must make sure certain information is 
in your practice records. Use the following table to help you verify your records are complete.

Field(s) to complete Screen or tab on which the field is 
located

Practice Tax ID Practice Information screen, Practice 
IDs rules
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You must also apply security to your practice and create at least one user. For more information on 
CGM MEDISOFT security, see “Security Setup Overview” on page 31. 

Eligibility Verification Results
There are multiple places in CGM MEDISOFT from which you can make eligibility verification 
requests: the Eligibility Verification Results screen, the Patient List screen, Office Hours, and the 
Task Scheduler screen. The type of eligibility inquiry you make, either real-time or scheduled, 
depends on the screen from which you are making the request.  

Eligibility Verification Results
If you access this screen from the Activities menu, it will automatically show the last inquiry made 
for each patient. You can also set it to show all inquiries. 

To make a real-time eligibility inquiry from the Eligibility Verification Results 
screen: 
 • Highlight the patient and click the Verify button.  

Tax ID Providers screen, Provider IDs tab (if this 
value is different from the Practice Tax 
ID above)

Claims Payer ID Insurance Carriers screen, EDI/Eligibility 
tab

Last Name, First Name, Date of Birth, 
Gender, Social Security Number

Patient/Guarantor screen, Name/
Address tab

Assigned Provider Patient/Guarantor screen, Other 
Information tab

Insurance, Policy Holder, Relationship 
to Insured, Policy Number.

Case screen, Policy tabs

Assigned Provider Case screen, Account tab

Field(s) to complete Screen or tab on which the field is 
located
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Patients

To make a real-time eligibility inquiry for a specific patient: 
1. Right-click the patient's case in the Patient List and click Eligibility Verification.
2. The Eligibility Verification Results screen appears.  
3. Click the Verify button to make the inquiry.

TIP: Press F10 to launch the Eligibility Verification Results screen to verify a patient's eligibility. 

Task Scheduler
You can use the Scheduled Tasks feature to schedule a daily time to send a batch of eligibility 
inquiries. To schedule a batch, 

1. On the Activities menu, point to Eligibility Verification and click Schedule. The CGM 
MEDISOFT Task Scheduler screen appears.

2. Click the New button. The Select Type screen appears.
3. Select Eligibility.
4. Click the OK button. The Select Practice screen appears.
5. Select the practice and click the OK button. The New Eligibility Task screen appears.
6. Complete the options and click the Save button. The new task appears on the CGM 

MEDISOFT Task Scheduler screen.
The task will automatically make inquiries for patients scheduled in the appointment grid up to a 
week in advance.  
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In this chapter you will learn about Office Hours and some of the basic features available for 
creating and managing patient appointments.

Office Hours Overview

Office Hours is an appointment scheduling program that helps keep track of appointments for your 
practice.  It is automatically installed with CGM MEDISOFT.

Starting the Program

 • On the Activities menu, click Appointment Book.

Office Hours Setup

There are several sections of the program that must be set up before you start scheduling.

1. First, set up provider records.  If you are booking appointments for lab work or therapy, each of 
those technicians will have a provider number and schedule and so will each office member 
whose schedule will be included in the Office Hours program.

2. Set up your patient records.  
3. Create your resource records. You can include all treatment apparatuses in this list, as well as 

consultation and treatment rooms, so that you do not double-book a room or equipment.
4. Set up program options, such as establishing appointment length, creating whatever views 

you need for viewing multiple columns at once, and deciding how much information you want 
displayed in your appointment blocks in the appointment grid.  

5. Set up breaks and recurring breaks, to show lunch hour, set coffee-type breaks, seminars, and 
so on.

6. Set up security.
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Using Office Hours

Entering a New Appointment

You can enter a new appointment on the Appointment Grid that opens when you start Office Hours. 
To create a new appointment

1. Select a provider in the provider field in the top right of the grid.
2. Double-click the timeslot for which you want to enter an appointment. The New Appointment 

Entry screen appears. 

TIP: If you want to set up an appointment for someone who is not a patient and has no chart 
number, skip the Chart field and enter the person’s name in the Name field. Enter all other 
necessary information. You can also print the appointment list showing blank appointments and 
manually write in appointments. Also, If a patient’s case has an Authorized Number of Visits set on 
the Account tab of the Case screen, the program will warn you when the patient approaches the 
maximum number of authorized visits.

3. In the Chart field, type or select the patient’s chart number.  
4. Select a value for the Resource field. 
5. Enter any notes about the appointment in the Note field. If you want to create a new line in the 

note, press CTRL + ENTER.
6. In the Case field the newest case entered for the patient appears. To change the case to which 

the appointment is tied, click the arrow to select the case. 

Tip: You can right-click the field to create a new case, edit the selected case, or copy the selected 
case.

7. Select a value for the Reason field.
8. Enter the appointment length of time in the Length field. Enter the date in the Date field.
9. Enter the time in the Time field. 

10. Select a button for the Status of the appointment. The default value is Unconfirmed.
11. If necessary, click Need Referral to indicate the patient does not have a referral for his or her 

visit. 
12. If the patient must make a co-payment, click Enter Copay. This will open the Enter Copay 

screen on which you can enter the patient’s co-payment.
13. Click the Save button. The appointment appears on the Appointment Grid.

Find Open Time
You can use the Find Open Time feature to have the program search for the next available opening 
for an appointment. To do so

1. On the Edit menu, click Find Open Time. The Find Open Time screen appears.
2. Complete the fields and click the Search button. Office Hours shows you the next available 

time on the grid.
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Go To Date
If you need to locate a date that is a given length of time in the future, use the Go To Date screen. 
To do so

1. From the Edit menu, click Go to Date. The Go to Date screen appears.
The date that defaults in the Date From field is the date that is currently selected in the 
calendar.  If you want to change the date in the Date From field, replace it by either highlighting 
and typing in a new date, or click in the field or on the down arrow to the right of the field and 
the calendar opens.

2. Enter a number in one of the selection boxes to indicate how far in the future you need to make 
the appointment. For example, if you need an appointment in six months, type the number 6 in 
the Months field.

3. Click the Go button. 

Wait List
The Wait List is available to track any unexpected patients who need to be seen that day. If no 
openings are available when patients call in, you can put them on the Wait List. If a time slot 
becomes available, you can use the Wait List to help you determine whom to call first for that 
opening.

Moving a Patient from the Wait List to an Open Appointment
1. On the View menu, click Wait List. The Wait List screen appears.
2. Use the Search/Sort by fields to search for a record. Select the field by which you want to 

search in Sort by and then enter the value for which you want to search in Search.
3. Select the Provider.
4. Choose a patient from the list and click and drag their name to an open time slot in the 

Appointment Grid. 

Adding a Patient to the Wait List 

To create a new entry for the Wait List:
1. On the View menu, click Wait List. The Wait List screen appears.
2. Click the New button in the Wait List. The New Wait List Appointment screen appears.  
3. Select a patient in the Chart Number field. The patient’s name and phone number are 

automatically entered in those fields when you tab past them. 

NOTE: Entering a phone number here does not store that number in the patient’s record. To 
include a phone number in the patient’s permanent record, enter the phone number in the Patient/
Guarantor screen. You can move the cursor back to the Name field, and then press F9 to edit the 
patient record.

4. Complete the remaining fields on the New Wait List Appointment screen.
5. Click the Save button. 
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Editing an Appointment

To edit an appointment:
1. Double-click the appointment or right-click the appointment and click Edit from the drop-down 

menu. The Edit Appointment screen appears.
2. Make the changes you want.
3. Click the Save button.

Changing a Telephone Number or Cell Phone
If you update a patient's appointment with a new telephone number, you can also update all future 
appointments with the new phone number. When you enter the new phone number and click, the 
following screen appears:

Figure 117.  Confirm Phone Change screen

 • If you click the Yes button, all future appointments are updated.
 • If you select the Do not show this message again check box, the Confirm Phone Change 

screen will not appear in the future when you change other telephone numbers; the system will 
automatically update the phone number. 

 • If you click the No button, the patient’s phone number for all future appointments will remain 
the old phone number. 

Changing Other Information
If the field has an arrow key, you can click the arrow and then select from the drop-down list. If the 
field has a Search icon, you can click the icon and search for the corrected information. 

Viewing Scheduled Appointments

You can view all the appointments scheduled for a patient. 

1. On the Lists menu, click Patient List. The Patient List screen appears.
2. Highlight the patient whose appointments you want to view and click Edit Patient. The 

Patient/Guarantor screen appears.
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3. Click the Appointments button on the right. The Scheduled Appointments screen appears.

Figure 118.  Scheduled Appointments screen

 •Click Show all appointments to view all appointments for this patient. 
 •Click the Edit button to edit the selected appointment. 
 •Click the New button to create a new appointment.
 •Click the Delete button to delete the selected appointment. 
 •Click the Print button to print the appointments in the grid. 
 •Click the Close button to exit the screen.

Viewing Future Appointments 

You can see the future appointments for each patient. Future appointments can be scheduled for 
up to a year in advance. When you open the Future Appointments screen, however, only the next 
60 days of appointments, based on the current system date, will appear. The future appointments 
that appear in this screen will change as the system date advances. 
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Using the Future Appointment List screen
1. Right-click the patient's appointment on the Appointment Grid and click Future 

Appointments. The Future Appointments List screen appears. It will show you appointments 
for this patient for the next 60 days. 

Figure 119.  Future Appointment List (next 60 days screen)

2. Click the Print Grid button to print the list or click the Close button to exit.

Using the Edit Appointment screen
CGM MEDISOFT will also notify you if the patient has future appointments scheduled when you 
open the Edit Appointment screen.

1. From the Appointment grid, right-click an appointment and click Edit.
2. Press Tab to move the cursor to the Home Phone field.
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3. If the patient has future appointments scheduled, you will see the notification on the screen.

Figure 120.  Edit Appointment screen with future appointment notification

4. Click the magnifying glass to open the Scheduled Appointments screen. 

You can see all of the patient’s appointments from this screen. You are not limited to the next 60 
days.

Rescheduling an Appointment

You can reschedule an appointment by opening it and changing its status to Rescheduled. The 
Wait List will open, allowing you to find an open appointment time for the patient.
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To reschedule an appointment:
1. On the Appointment grid, right-click the appointment and click Rescheduled. The Wait List 

screen appears. 

Figure 121.  Wait List screen 

2. On the Wait List screen, click the Find button. The Find Open Time screen appears.
3. On the Find Open Time screen, select/modify criteria for selecting a new appointment.
4. Click the Search button. The Confirm screen appears.
5. On the Confirm screen, select one of these options

 •Click Yes to set the appointment.
 •Click No to reject the appointment. 
 •Click Retry for the next available appointment.

Moving/Deleting an Appointment

Moving an Appointment
To move an appointment, select one of the following methods:

Drag and Drop (changing to same day only):
1. Click the appointment and hold the mouse button down.
2. Move the cursor to the new appointment time.
3. Release the mouse button. 

Using accelerator keys:
1. Highlight the appointment by clicking the grid cell.
2. Press ALT + X to cut the appointment.
3. Move to the new date on the Appointment Grid.
4. Click the new appointment time.
5. Press ALT + V to paste the appointment in the new location.

Using the Speed menu:
1. Highlight the appointment by clicking the grid cell.
2. Right-click the mouse and click Cut.
3. Move to the new date or new time.
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4. Click the new appointment time.
5. Right-click the mouse and click Paste.

Using the Edit menu:
1. Highlight the appointment by clicking the grid cell.
2. On the Edit menu, click Cut.
3. Move to the new date.
4. Click the new appointment time.
5. On the Edit menu, click Paste.

Deleting an Appointment
To delete an appointment

1. Highlight the appointment on the grid by clicking it.
2. Right-click and click Delete.

NOTE: When you delete an appointment to which a numbered superbill is attached, the superbill is 
also deleted. The number may be released for reassignment.

Recalling Patients

The Patient Recall List screen displays all patients who have been set up for appointment recalls. 
The recall list provides staff a list of patients who need to be contacted for various reasons, for 
instance, contacting a patient regarding a follow-up visit or paying a bill.

This screen is for information purposes only and it does not integrate with any other part of Office 
Hours.

To open the Patient Recall List:
1. On the Lists menu, click Patient Recall. The Patient Recall List appears.

Figure 122.  Patient Recall List screen
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This screen is different from the other lists because you can search for a record by its date. When 
using the date as a search parameter, there are various date formats you can use. The following 
table explains the formats that are acceptable to use when searching. 

2. From this screen, you can
 •Click the New button to add a new entry.
 •Click the Edit button to update an existing entry.
 •Click the Delete button to remove an entry.
 •Click the Print Grid button to print a list of patients on this list. 

Setting Program Options

There are several options you can choose from. You can access Program Options from the 
Program Options option on the File menu.

Options tab

Figure 123.  Program Options - Options tab

Set the starting and ending appointment times for the practice.  Enter the Starting Time and 
Ending Time, breaking it down by hour and minutes.  Standard appointment Intervals can be 
established by scrolling with the up and down arrows.  

You can also set colors to distinguish appointments, breaks, and conflicts.  Make decisions 
concerning all the other default settings in this tab.
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Designate one of the reports in the Speed Report box and it will automatically print when you click 
the Print speed button.

You can now choose to use Deposit Entry or Transaction Entry when entering a copay.  To use 
Transaction Entry rather than Deposit Entry, click the Use transaction Entry to Make Copays check 
box.  

Multi Views tab

Figure 124.  Program options - Multi Views tab

Office Hours provides one Multi View setup, which automatically includes all providers and all 
resources, each with its own column. You can create as many Multi Views as you need in the Multi 
Views tab.   

The open data entry field lists all Multi Views that have been set up. This is where you can group 
providers and/or resources (rooms or facilities scheduled for appointments) in any combination 
desired, or modify or delete existing multiple view setups.  Click the New button to set up a new 
Multi View (select a view and click the Edit button to make changes).  
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In the New View screen, assign a name for the new view. For the first column, indicate the type 
(Provider or Resource), the Code (provider number or resource code), then the width of the column 
(in pixels). Set up each column you want in the view and click the Close button when finished.  

Figure 125.  New View tab

If you want to add a column between columns that have already been created, place your cursor 
where you want the new column and click Insert. 

These views can be also edited or reverted to default views through the View menu.

Appointment Display tab

Figure 126.  Appointment Display tab
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In the Appointment Display tab, you can specify up to five rows of information to display in the grid 
for an appointment. Be aware that the length of the appointment determines how much data is 
actually displayed on the grid. An appointment must be at least 75 minutes long to display five rows 
of information.
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In this chapter you will learn about reports in CGM MEDISOFT.

Reports Overview

CGM MEDISOFT offers flexible reporting options.You can run reports in CGM MEDISOFT by 
selecting various reports from the Reports menu. In addition, you can launch the CGM MEDISOFT 
Reports application (for CGM MEDISOFT Advanced and CGM MEDISOFT Network Professional 
only) and complete all reporting tasks there. The CGM MEDISOFT Report application offers 
several key features not available when running reports from the Reports menu, including different 
reports and features to enhance productivity. 

Report Procedures

Viewing a Report
You can view or preview a report before printing or exporting it.  For example, you could preview a 
Patient Aging report before printing it to make sure that you have selected the most appropriate 
data criteria. After previewing, you can export or print the report.

To view a report: 
1. On the Reports menu, select the report you want to view. The Print Report Where? screen 

appears. 
2. Select Preview the report on the screen. 
3. Click the Start button. Depending on the report selected, the Data Selection Questions screen 

or the Search screen opens. 
4. Select ranges and then click the OK button. The report appears. 

NOTE: For some reports that use a different format, such as statements, the controls in this screen 
are slightly different and include a Save Report to Disk option.  

Printing a Report

To print a report: 
1. On the Reports menu, select the report you want to print. The Print Report Where? screen 

appears.
2. Select Print the report on the printer. 
3. Click the Start button. Depending on the report selected, the Data Selection Questions screen 

or the Search screen opens. 
4. Select ranges and click the OK button. The Print screen appears.
5. Click the OK button. 
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Exporting a Report 
You can export a report into another format. For example, you could export a Patient Aging report 
to a Microsoft Excel spreadsheet. 

To export a report:
1. On the Reports menu, select the report you want to export. The Print Report Where? screen 

appears.
2. Select Export the report to a file and click the Start button. The Save As screen appears.
3. Select a file format for exporting and a destination. 
4. Click the Save button. The Search screen or the Data Selections Questions screen appears 

(depends on the report or statement selected).
5. Select appropriate criteria and click the OK button. The report is exported. 

Searching for a Specific Detail in a Report
Once you have generated a report, you can further refine the report and search for a more detailed 
data element. When using this feature, you essentially re-run a report using more specific data 
criteria.    

To refine your data criteria and search for specific data:
1. View a report. See “Viewing a Report” on page 163.
2. Click the Search button. The Search screen appears.
3. Select specific data ranges.
4. Click the OK button. The report displays using the new search criteria.  

Available Reports

Not only does CGM MEDISOFT build an accounts receivable file and handle statements, 
insurance claims, and electronic billing, it also provides a variety of reports that can give you a 
better understanding of the day-to-day workings of your practice.

Among the reports generated within CGM MEDISOFT are Day Sheets, Analysis Reports, Aging 
Reports, Productivity Reports (Network Professional), Activity Reports (Network Professional), 
Collection Reports (Advanced and CGM MEDISOFT Network Professional), Audit Reports, Patient 
Ledger Report, Guarantor Quick Balance List (Network Professional only), and Standard Patient 
List Reports.  

You can also print a title page that shows all the filters used in preparing the report.   

Day Sheets 
Day Sheets are available in three reports. 

Report Description

Patient Lists each patient’s name, showing all transactions and a summary of 
activities for the day.

Procedure Breaks down by procedure code the activities of the day, summarizing 
patients treated for each procedure.
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Payment Shows the payments made on the requested day and the charges to which 
the payments are applied.

Report Description
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Analysis Reports
Report Description

Billing/Payment Status Report (Advanced and 
CGM MEDISOFT Network Professional)

Provides a thumbnail sketch of the current 
billing and payment status of each claim. The 
report shows what has been billed and not 
billed, what is delayed for some reason, if the 
carrier is not responsible or has refused the 
claim, or if the claim is paid in full. An asterisk 
(*) next to an amount indicates that the entity 
has paid all it is going to pay; and the balance, 
if any, should go to the next responsible payer.

Insurance Payment Comparison (Network 
Professional only)

Compares the payment records of all carriers 
in the practice.

Practice Analysis Summarizes the activity of a specified period 
(for example, a month), listing each procedure 
performed, the number of times it was 
performed, and the total dollar amount 
generated by each procedure. It shows the 
average charge, includes any costs involved 
with that procedure, and calculates the net 
monetary effect on the practice’s income.  

Insurance Analysis (Advanced and CGM 
MEDISOFT Network Professional)

Summarizes all claims filed by category 
(Primary, Secondary, and Tertiary).  Claims 
totals are shown for charges and insurance 
payments in both dollar amount and 
percentage.   

Referring Provider Report (Advanced and 
CGM MEDISOFT Network Professional)

Shows which patients were referred by other 
practices and the percentage each referral 
contributes to the overall referred income of the 
practice, as of the date of that report. The 
report also includes the UPIN of the referring 
provider. By blanking out the Referring 
Provider range in the Data Selection Questions 
screen, a report can be generated showing 
what percentage of the entire practice has 
been referred.
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Referral Source Report (Advanced and CGM 
MEDISOFT Network Professional) 

Assembles the patient list by source (other 
than provider) and shows how much revenue 
comes from each source, allowing the practice 
to identify those sources that send profitable 
referrals and/or limit those that are costly or 
nonproductive.  

This is another report for tracking the source of 
patients who come to the practice. For the 
report to work, however, all referral sources 
must be entered in the Address Book. A 
source can be an attorney, a hospital, friends, 
other patients, or anything else. Most new 
patient application forms include the inquiry 
“How did you hear about us?”  

Facility Report (Network Professional only) Tracks patients who are seen at different 
facilities. The Facility Report assembles the 
patient list by facility and shows how much 
revenue comes from each facility, helping you 
identify which generates the most money.

Unapplied Payment/Adjustment Report 
(Advanced and CGM MEDISOFT Network 
Professional)

Shows any payment or adjustment that has an 
unapplied amount and where the transaction 
can be found.  

Unapplied Deposit Report (Advanced and 
CGM MEDISOFT Network Professional) 

Shows all deposits that have an unapplied 
amount.

Co-Payment Report (Advanced and CGM 
MEDISOFT Network Professional) 

Shows all patients who have co-payment 
transactions. It shows the amount of the 
required co-payment, how much was applied, 
and what was left unapplied. If a patient does 
not have any co-payment transactions, he or 
she is not included in the report.    

Outstanding Co-Payment Report (Advanced 
and CGM MEDISOFT Network Professional)

Shows all patients who have outstanding co-
payment transactions. The report shows the 
Co-payment amount expected, the actual 
amount paid, and the amount due. If a patient 
has no outstanding co-payment transactions, 
he or she is not included in the report.

Appointment Eligibility Analysis - Detail Report Shows patients with appointments whose 
eligibility has been checked, based on criteria 
entered. It includes detail about the patients, 
their appointment date and time, the provider 
name, and reason code. It is an ARRA report 
designed for showing that the practice is 
verifying eligibility electronically.

Report Description
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Appointment Eligibility Analysis - Summary 
Report 

Shows a summary of appointments whose 
eligibility has been checked, based on criteria 
entered. It is an ARRA report designed for 
showing that the practice is verifying eligibility 
electronically.

Electronic Claims Analysis - Detail Report Shows the status of claims, providing a 
summary of total claims and those that have 
been filed electronically or by paper. It includes 
the percentage of claims filed electronically. In 
addition, it shows detail such as the billing 
date, insurance carrier, sequence, claim 
number, patient chart and name, and the 
status of the claim. It is an ARRA report 
designed for showing that the practice is 
sending claims electronically.

Electronic Claims Analysis - Summary Report Shows the status of claims, providing a 
summary of total claims and those that have 
been filed electronically or by paper. It is an 
ARRA report designed for showing that the 
practice is sending claims electronically.

Report Description
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Aging Reports 

Production Reports 

NOTE: This is a Network Professional only feature.

Report Description

Patient Aging Shows patient aging. Default aging criteria is 
based upon the number of days between the 
creation of the transaction or claim and the date of 
the report you are generating. The columns break 
down the amounts due that are 30, 60, and 90+ 
days old. Aging is from actual date of the 
transaction, so it reflects the true age of the 
account. The aging criteria and columns can be 
altered in Program Options.  This report includes 
all unapplied amounts in the totals. The Date filter 
has been removed as it would return invalid 
values.  

Patient Remainder Aging (Advanced and 
Network Professional only) 

Has the same format as the Patient Aging, but 
there is a key difference in how it works.  A charge 
does not show up on the Patient Remainder Aging 
report until all insurance responsibility has been 
marked complete.  

Patient Remainder Aging Detail (Advanced 
and Network Professional only) 

Has the same criteria as Patient Remainder Aging 
Detail. However, it also lists each insurance 
company on the patient’s account and the date the 
insurance payment was marked complete.  

Insurance Aging and Summary Track aging of claims filed with insurance 
carriers. The summary versions are similar but no 
patient information is included. 

Report Description

Production by Provider, Procedure, and 
Insurance and Summary

Gives incoming revenue information for 
each provider, procedure, or insurance 
carrier, respectively. 
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Activity Reports 

NOTE: This is a Network Professional only feature.

Collection Reports 

NOTE: This is an Advanced and CGM MEDISOFT Network Professional feature.

Report Description

Daily/Monthly Activity Report Presents financial activity based on the 
date range selected. The report displays 
the total number and the total amounts of 
the charges, payments, and adjustments 
entered during a date range. The report 
also details the net effect of the financial 
information entered on the Accounts 
Receivable balance for the day/month.

Activity Summary by Provider/Insurance 
and Procedure 

Breaks down financial activity by day or 
month. The summary reports summarize 
financial information entered for each 
provider/procedure or insurance carrier, 
respectively.

Report Description

Patient Collection Report Contains information based on statements 
marked Sent in the Statement 
Management screen, showing what has 
not been paid, statement date, and so 
on. Also, select this Patient Collection 
Report to generate the report with 
statement notes included.

Insurance Collection Reports Shows the claim data, what amount is 
outstanding, and so on. These reports also 
offer variants that include claim notes. 

Patient Collection Letters Printed in preparation of collection letters.  
It contains information from the collection 
list and is used to help evaluate 
collections.  

Collection Tracer Report Reports how many collection letters have 
been sent and when. Each time collection 
letters are printed, CGM MEDISOFT, by 
default, keeps track of each letter sent.  



CGM MEDISOFT 27
December 2022 27 171

Chapter 27 - Reports Audit Reports

Audit Reports
Report Description

Audit Generator Creates a data audit report that contains only the 
information you want included in the report. This 
report is intended as a protection for the practice to 
keep track of changes made and by whom.

Some PHI (personal health information) will be 
included in the Data Audit Report no matter what 
selections are made or excluded in the Program 
Options screen or the Audit Generator.

NOTE:  This report does not support printing a 
report title page even if the Print Report Title Page 
option was set in the Program Options screen.

Login/Logout This report allows you to track login/logout activity 
in the practice, including the user name and 
machine name of each login, along with a date and 
time stamp.
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This chapter gives a brief overview of the different program options available in CGM MEDISOFT.

General Tab

The General tab has options for backups, which are an essential part of maintaining computer-
generated billing programs, and general default settings, such as which screen to open on startup, 
and several options to show or hide data. 

Figure 127.  Program Options screen - General tab
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Data Entry Tab

The Data Entry tab gives you many options for various sections of CGM MEDISOFT. 

Figure 128.  Program Options screen - Data Entry tab

In the Global section, you can indicate whether to use the ENTER key to move between fields, to 
force payments to be applied, and to multiply unit times amount. When the Suppress UB04 Fields 
check box is selected, UB-04 fields do not appear throughout CGM MEDISOFT. 

In the Patient section, you can choose to use numeric chart numbers (the default is to use an 
alphanumeric code) and/or have CGM MEDISOFT automatically hyphenate Social Security 
numbers. The Patient Quick Entry Default list and the Use Quick Entry for New Patient/Case F8 
and Use Quick Entry for Edit Patient/Case F9 check boxes provide setting options for the Patient 
Quick feature, which provides a custom method for creating records.  

Payment Application Tab 

NOTE: This is an Advanced and CGM MEDISOFT Network Professional tab.
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In the Payment Application tab, you can establish default settings that affect payments when you 
apply them to patient balances.  

Figure 129.  Program Options screen - Payment Application tab

If you choose to accept the default settings, any amount applied to a charge is automatically 
marked as paid by that particular payee, the allowed amount is automatically calculated, and the 
difference between the calculated allowed amount and the practice charge is offset in the 
Adjustment column. In addition, any claim that has received payment from all responsible payers is 
automatically marked “Done.” 

In the lower half of the screen, select default billing codes to be applied when using this feature.  

Aging Reports Tab

The Aging Reports tab lets you alter the starting date for patient aging reports and to redefine 
aging columns for both patient and insurance aging reports.  

HIPAA Tab/ICD 10

The HIPAA tab offers features designed to help protect patient information from unauthorized 
access.  
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The Auto Log Off check box is designed to protect your data files from unauthorized 
tampering. Select the check box and then enter a number of minutes (up to 59) in the field. With 
Auto Log Off activated, any time CGM MEDISOFT remains unused for the amount of time 
designated, it locks the practice and requires re-entry of a password to access CGM MEDISOFT 
again.

If you select this check box and have not used the Security Setup feature in CGM MEDISOFT, a 
message pops up telling you that security has to be set up before the backup will function. For 
more information on security, see “Security Setup Overview” on page 31.  

When the Warn on Unapproved Codes check box is selected, CGM MEDISOFT alerts you if a 
code entered or selected is non-HIPAA compliant. This warning pops up every time you save 
transactions and CGM MEDISOFT finds a code that has not been marked HIPAA compliant.  

Color-Coding Tab 

NOTE: This is an Advanced and CGM MEDISOFT Network Professional tab. 

Transactions
If you want to use color coding for transactions in Transaction Entry and Quick Ledger, select the 
Use Color Coding check box.  

Select colors for each of six types of transactions: unsaved, no payment, partially paid, overpaid 
charge, unapplied payment, and overapplied payment. These colors appear in both screens, 
letting you know at a glance the status of the transaction.

Patients
This feature, called patient flagging, lets you color code patient records to alert you to various 
situations when viewing records.

The patient flag colors in the Program Options screen are fixed and cannot be edited. In the box to 
the right of a color box, assign your own description to that flag color. To activate the edit boxes, 
select Use Flags.  

Patient flags are connected to patient records in the Other Information tab of the Patient/Guarantor 
screen as you edit or set up a new patient record.  

Billing Tab 

NOTE: This is an Advanced and CGM MEDISOFT Network Professional feature. 
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Statements
Options in the Statements section deal with billing cycles. If you want to use billing cycles when 
sending statements, select the Use Cycle Billing checkbox. If you choose to use cycle billing, be 
sure to enter a cycle billing days interval (for example., every 30 days). For more information on 
billing cycles, see “Billing Cycles” on page 126. Statements sent through BillFlash are also affected 
by the billing cycle.

The Add Copays to Remainder Statements is used to add missed copays (when patients do not 
immediately pay their copay), to the patient’s Copay Remainder statement. 

Figure 130.  Program Options screen - Billing tab 

Billing Notes
When you select Create statement billing notes, CGM MEDISOFT adds a note to statements when 
printed. Be sure to select a default note in the Statement Billing Note Code field.  

When you select Create claim billing notes, CGM MEDISOFT adds a Comment transaction line in 
both Transaction Entry and Quick Ledger whenever a claim is billed. The note includes the carrier 
name, date billed, claim number, and the name of the provider associated with the claim.  Be sure 
to select a default Claim Billing Note Code.  
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Audit Tab 

The Audit tab lists all tables available in the database. The tables you choose here become 
available in the Audit Generator when preparing the Data Audit Report. 

Figure 131.  Program Options screen - Audit tab
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BillFlash Tab 

The BillFlash tab allows you to control some of the information that appears on the statements you 
send electronically via BillFlash, the web based company that is set up to process electronic 
statements in CGM MEDISOFT. 

Figure 132.  Program Options screen - BillFlash tab
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In this chapter you will learn how to back up and restore data using both the regular and 
hot backup/restore features. 

Backing Up Your Data 

Making regular backups is essential to good maintenance of your data. 

Best Practice--consider backing up data files every day so you can restore lost data to the 
most recent date before the files were damaged or corrupted. If you are working with 
multiple practices, each practice will have its own set of backup files. Doing your backups 
within the CGM MEDISOFT program is a dependable method. 

Important! Prior to making a backup, you must stop the MPIC service and the Mobile 
service. Follow these steps to stop those services.

1. Click the Start button.

2. Enter services in the Search programs and files field.

3. Press Enter. The Component Services screen appears. 

4. Click Services (local). The list of services appears.

5. Find McKesson MSL Mobile Api Server. Right-click and select Stop.

6. Find MPICservice. Right-click and select Stop.

7. Launch CGM MEDISOFT, open your practice, and make a backup.

8. Return to the Component Services screen and restart McKesson MSL Mobile Api 
Server and MPICservice.

To make a backup: 
1. On the File menu, point to Backup, and click Backup Data.

2. Click the OK button on the warning message. The CGM MEDISOFT Backup screen 
appears. 

3. Complete the fields on the screen. 

4. Click the Start Backup button.

5. Click the OK button on the message that the backup is complete. 
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Restoring Your Data 

You will very seldom have to restore a backup. it is only necessary if the data becomes 
corrupted or you have to print reports that are no longer accessible because of the addition 
of new data. eMDs highly recommends that you create a new backup of your current data 
BEFORE you restore your backup. You may need this backup to restore your files to their 
current state. 

To restore a backup: 
1. On the File menu, point to Restore, and click Restore Backup. 

2. Click the OK button on the warning message. The CGM MEDISOFT Restore screen 
appears. 

3. Select a backup on the list of existing backups or click Find to find a different backup. 

4. Click the Start Restore button. A confirmation screen appears. 

5. Click the OK button.The backup is restored. 

6. Click the OK button. 

7. Click the Close button on the CGM MEDISOFT Restore screen. 

Making a Hot Backup 

This feature is for CGM MEDISOFT Network Professional only. 

Hot Backup allows you to make a backup of your data while other users are still working in 
the practice. Hot Backup will ensure that processes are completed before creating the 
backup. Once the backup is complete, you will be logged out of CGM MEDISOFT and 
must log back in to resume work.

To make a hot backup: 
1. On the File menu, point to Backup, and click Hot Backup. The CGM MEDISOFT Hot 

Backup screen appears. 

2. Complete the fields on the screen. 

3. Click the Start Backup button. 

4. Click the OK button on the message that the backup is complete. 

Restoring Your Hot Backup 

You will very seldom have to restore a hot backup. it is only necessary if the data becomes 
corrupted or you have to print reports that are no longer accessible because of the 
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addition of new data. eMDs highly recommends that you create a new backup of your 
current data BEFORE you restore your backup. You may need this backup to restore your 
files to their current state.

To restore a hot backup: 
1. On the File menu, click Restore. 

2. Click Hot Restore. 

3. Click the OK button on the warning message. The CGM MEDISOFT Hot Restore 
screen appears. 

4. Select a backup on the list of existing backups or click the Find button to find a 
different backup. 

5. Click the Start Restore button. A confirmation screen appears. 

6. Click the OK button.The backup is restored. 

7. Log back into CGM MEDISOFT.
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CGM highly recommends that you make a full backup prior to merging patients! In addition, be 
sure to process any Unprocessed Transactions for the patient whose record you are merging to 
another patient record. If you interface with an EHR, do not allow other users to add appointments 
for the source patient while a merge is in process. 

In addition, CGM recommends that:

 • No other users are accessing the source or target patient while the merge is in process.

 • Close the Patient list and Office Hours prior to merging patients.

You can now merge two patient records if there are duplicates in your system. When you merge, 
the following data will be merged:

 • All Cases (and all information inside those cases including images) from the Move From 
(source) patient will be added to the Move Into (target) patient so that the Move To (target) 
patient has any original cases, as well as the ones added via the merge. 

Warning note: Potentially, now that cases have been moved, the ‘last used’ case on the 
Move To (target) patient will be different. 

 • Everything in Transaction Entry (all transactions--charges, payments, adjustments, 
statements, and claim notes, etc.) will now be associated with the Merge To (target) patient

 • All claims from the Move From (source) patient will now be associated with the Move TO 
(target) patient 

 • All Statements from the Move From (source) Patient will now be associated with the Move To 
(target) patient 

 • All appointments will be moved to the Move To (target) patient 

 • Phone numbers in appointments/recalls/waitlist: if the numbers in the most current 
appointment are the same as the numbers in the FROM patient, all appointments will have the 
number of the TO patient when merged.

 • If there are “one-off” phone numbers in the most recently added appointment of the FROM 
patient, where a number was changed in that appointment so it differs from the one(s) in the 
patient record, the merge will place that number in all appointments of the From patient once 
merged. The Waitlist and Recall will also have these number(s) after the merge. 

 • If there are no appointments for the FROM patient and the patient is on the Waitlist or has a 
Recall set and there are one-off numbers in FROM patient in Waitlist or Recall. after the merge 
the numbers in the Waitlist and Recall are left as they were entered in Waitlist and Recall on 
the FROM patient

 • All AR tracker items (tasks, status, notes, etc., will be moved).

 • All Archived records are merged

 • Final Draft: No changes will be made during the merge. 



CGM MEDISOFT 27
186 27 December 2022

Chapter 30 - Merge Patients

 If you have any Final draft documents, you will need to manually change the file name of any 
documents saved with the From patient to the TO patient.

Final draft documentation Information or document text will NOT be changed during the 
merge. You must do this after the merge has taken place. 

 • If the Move From Patient (source) was a Guarantor or Policy Holder for any other patient, the 
Move To (target) patient will be replaced in those patients’ corresponding fields.

What will not be merged
Demographic data (name, address, telephone number, etc.) will NOT be moved between patients. 
The system assumes that the Move To patient's demographics are correct and the most current.

It is recommended to do the merge when others are not using the system, However, if you do a 
merge while other users are in the system, you may encounter an error during the Merge because 
another user has a record in use/locked:

 • If there is an issue anywhere during the merge, you will need to fix the issue and start again. 
Otherwise, the Merge From patient will still exist and there will still be entries in tables not 
processed with the old patient until you finish the process.

Refresh
The Patient List and Office Hours grids do not refresh automatically after the merge. Consequently,, 
if someone is merging, other users may still see that patient on the list until they close and reopen 
the list. Be sure to instruct them to refresh the Patient List.

If the Patient List is open and cursor focus is on the move FROM patient and the user opens the 
Patient ledger, the ledger will open with the chart of the patient who is no longer there and the 
name of first patient in the patient list. In this case, simply pick another patient or close the list and 
reopen to refresh

Merging Patients and Interfaces with CGM MEDISOFT
If you are merging patients and use an EHR: CGM MEDISOFT does not send a Merge HL7 
message, so with some EHRs there is some pre- or post-work that needs to be done.  

For all EHRs: 

The CGM MEDISOFT Office side needs to communicate with the EHR side to no longer use the 
source patient to send charges.

If your EHR has a merge option, it should be done immediately after 
merging in Medisoft. No one else in the system should be doing any 
activities involving the Merge From or To patients while the merge is in 
process.

If your EHR does not have a merge option, mark the From patient inactive in the EHR or  do 
whatever process is applicable in that clinical system so that chart is no longer used to send 
charges

If there is a patient already in Unprocessed Charges before the merge, and then the merge is 
performed, the merge process will update the chart in Unprocessed with the Merge TO chart and, 
in most cases, will work as normal and can be posted. However, if the name, date of birth, or SSN 
are different between the patient in Unprocessed (the original FROM patient) and the current 
patient record (the Merged TO patient), there will be a mismatch error and that charge cannot be 
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posted. That charge will have to be manually added in Transaction Entry and deleted from 
Unprocessed Transactions.

To avoid this, check Unprocessed Transactions prior to doing a merge and post the charges 
prior to the merge.

The most likely scenario for this is if there was a From patient who got married and the TO patient 
was added with the married/different name.

The table below describes the steps to perform (if any) for each EHR.

Merge Patient Warning message
This message reminds you of the changes to your patient records that will be made when you 
merge patients. Click Yes to proceed.

Figure 133.  Merge Patient Warning message

Interface Actions necessary

CGM APRIMA Use the Patient Merge feature in CGM APRIMA to merge the same two 
patients. For more information, see the CGM APRIMA Online Help topic 
“Merging Patient Records.”

CGM MEDISOFT 
EHR (Clinical) 

Use the Patient Merge feature in CGM MEDISOFT EHR (Clinical) to 
merge the same two patients. For more information, see the online Help 
topic in CGM MEDISOFT EHR (Clinical): “Merge Patients Utility.”

Plus Appointments/Demographics 

Nothing needs to be done. Any existing appointments for the FROM 
patient get updated with the TO patient and the highest case updates.

CGM MEDISOFT 
Mobile

CGM eMDs recommends that you do not do a merge while anyone is 
using these patients on a mobile device
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Merge Patient screen
Use this screen to select the patient records that you want to merge. 

 • In the Merge From Patient field, select the record that you want to be merged with the Merge 
Into Patient field. The Merge From Patient record will be DELETED when the process is 
complete. 

 • In the Merge Into Patient field, select the record that will receive data from the Merge From 
Patient record. This record will be RETAINED in CGM MEDISOFT after the process is 
complete.

Figure 134.  Merge Patient Utility screen

If you leave either field blank, you will receive an error message if you try to proceed.

Click Merge Now to merge the records. 

NOTE: CGM highly recommends that you make a backup BEFORE you merge records. In 
addition, process any Unprocessed Transactions for the FROM patient and close Office Hours. 
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This section defines terms used in the CGM MEDISOFT 27.

Care Plan Oversight Number
This is the number physicians have if they have supervision of Medicare patients under the care of 
hospices or home health agencies that require complex or multidisciplinary care.

CLIA Number
This is Clinical Laboratory Improvement Amendment Number. This number is required for all 
laboratory claims. 

EDI Receivers
These are the organizations to which you send claims or eligibility requests.

EOB
An EOB is one or more ready-to-mail forms containing claim-specific information. Each form lists 
the carrier’s payments, allowances, and insurance filing activity. EOBs are used mainly to inform 
secondary carriers of the payments and disallowances posted to a claim by the claim’s primary 
carrier. 

Insurance Class
Insurance classes enable you to categorize insurance carriers into groups.

Legacy identifier
This refers to a provider number or identification number other than NPI, such as a BCBS provider 
number, Unique Provider Identification Number (UPIN), Medicare number or Medicaid number.

Level One user
This is a user with the highest access level in CGM MEDISOFT, often an administrator.

List screen
These are screens that show lists of information, such as providers, insurance carriers, and so on. 
From these screens you can select an item to edit or create a new item for the list.

Mammography Certificate Number
The Mammography Certification Number is assigned to a provider certified to perform a 
mammography and is required on all mammography claims. 

McKesson Practice Interface Center (MPIC)
This is an interface application that can be installed and configured to connect CGM MEDISOFT 
with other applications. 

National Provider ID
This refers to a unique number for a physician or practice that identifies them.
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Open Item Accounting
A type of accounting where charges and payments for patients remain on the books and are not 
lumped together at the end of a fiscal period or year.

Provider Class
The provider class is a way of categorizing providers into groups. 

Quick Ledger
The Quick Ledger is a feature of CGM MEDISOFT that gives a quick reference for transaction and 
other information in the patient’s account.

Revenue Management
This is the application that is bundled with CGM MEDISOFT that enables a user to transmit claims 
and eligibility payments electronically. 

Rules
Rules are logic patterns set up in CGM MEDISOFT to ensure that claims are processed correctly 
for providers and practices based on requirements set by the government and insurance carriers. 

Superbill
The superbill is designed to be a physician's worksheet. The superbill displays a list of what 
procedures can be performed by the provider and the diagnoses related to it displayed in a list 
format.

Taxonomy Number
This is a number that specifies the type of practice the physician is in, for example, family practice 
or emergency medicine

UB-04
This is a form used by institutions to file claims to insurance carriers.

Unique Physician Identification Number (UPIN)
The Unique Physician Identification Number (UPIN) is a number assigned to physicians and others 
who are enrolled in the Medicare Program.



CGM MEDISOFT 27
December 2022 27 191

 Index

Index

A
access levels

users 33
Account tab

cases 88
activities menu 5
Activity Reports 170
Add Copays to Remainder Statements check 

box 177
addresses

entering 55
Aging Reports 169
Aging Reports tab 175
Alternate Code Sets 65
Analysis Reports 164
applying deposits 129
applying payments 129
Appointment Display tab 160
appointment length 158
Audit Generator 178
Audit Reports 171
Audit tab 178, 179
Auto Log Off check box 176
available reports 164

B
backing up data 181
backup

creating 181
Benefits Assigned field 50
BillFlash

defined 37
ePayments 131
overview 37
setting up 37
statement processing 145

BillFlash tab 179
Billing Code List screen 75
billing codes

creating 75
billing cycles 126, 177
billing service 36
Billing tab 176

C
Capitation Payment 131
Care Plan Oversight number 189

providers 44
case

setting up 87
Case number 107
Case screen 88

customizing 90
case setup 87
Cases

Account tab 88
cases

Comment tab 89
Condition tab 88
copying 89
creating 87
defined 87
Diagnosis tab 88
EDI tab 89
Medicaid and TRICARE tab 89
Miscellaneous tab 88
Multimedia tab 89
overview 87
Personal tab 88
Policy tabs 89

changing claim status 119
changing statement status 125
charges

entering 107
chart number setup 79
chart numbers 79

numeric only 79
chiropractic practice 35
claim filing status 23
claim form not centered 117
claim management

overview 113
Claim Management screen 114
claim manager

EDI receiver 113
EOB 113
role 113

Claim screen tab
defined 115

claims



 Index

CGM MEDISOFT 27
192 27 December 2022

changing status 119
creating 113
editing 114
filing 113
printing 115
reprinting 119
troubleshooting 117

Claims Payer ID field 51
CLIA number 189

providers 43
collection letters

customizing 143
Collection List screen 143
Collection Reports 170
collections

managing 133, 143
Color-Coding tab 176
Comment tab

cases 89
common keystrokes 9
Complimentary Crossover box 51
Condition tab

cases 88
Contact List screen 77
Contact screen 77
copying

cases 89
Create Claims screen 114
creating

address records 55
billing codes 75
cases 87
diagnosis codes 65
employer recordes 55
facilities 53
insurance carriers 50
insurance classes 49
users 31

creating a backup 181
creating a database 21
creating a practice 21
creating claims 113
creating multiple practices 22
creating patient records 80
creating rules 23
creating statements 121
creating users 31
customizing

Case screen 90
customizing collection letters 143
customizing the toolbar 2

D
Data Audit report 178
Data Entry tab 174
Data Selection Questions screen 163
Day Sheets 164
Deposit (new) screen 129
deposits

applying 129
Diagnosis Codes 65
diagnosis codes

creating 65
Diagnosis Codes window 65
Diagnosis List window 65
Diagnosis tab

cases 88

E
EDI Extra 1/Medigap field 51
EDI Receiver records 38
EDI Receivers 189
EDI tab

cases 89
EDI/Eligibility tab 51
edit menu 4
editing claims 114
editing statements 122
electronic claims processing 145
Eligibility Payer ID field 51
eligibility verification 145

Office Hours 147
Patient List screen 147
setting up 145

employer records
creating 55

EMR
defined 108

EMR and Medisoft 108
entering 25
entering charges 107
entering payments 129
entering transactions 107
EOB

defined 130
EOB payments 129, 130
ePayments 131

Deposit List screen 131
exporting

reports 164
exporting reports 164



CGM MEDISOFT 27
December 2022 27 193

 Index

F
facilities

creating 53
entering 53
rules 53

file claims as a group 26
file menu 4
filing claims 113

G
General tab 173
Global section

Data Entry tab 174

H
help menu 9
Hide Inactive/Closed Items 174
HIPAA

Auto Log Off checkbox 176
Warn on Unapproved Codes check box 176

HIPAA Tab 175
HL7 triggers 173
hot backup 182
hot restore 182

I
institutional claims

suppress UB04 fields 174
UB04 fields 174

insurance carriers
creating 50

Insurance Class 189
insurance classes

creating 49

K
keystroke shortcuts 9

L
Legacy identifier 189
Level of Subluxation field 35
lists menu 6
login/password management 32

M
making a backup 181
making a hot backup 182
Mammography Cert number

providers 43
Mammography Certificate number 189

managed care
defined 130

managing collections 133, 143
Medicaid and TRICARE tab

cases 89
Medisoft

menus 3
Medisoft Task Scheduler screen 147
Menu Bar 1
menus 3

activities 5
edit 4
file 4
help 9
lists 6
reports 7
tools 8
window 8

menus in Medisoft 3
Miscellaneous tab

cases 88
MultiLink codes 59
multimedia tab

cases 89
multiple booking columns 158

N
navigating in Medisoft 1
New Eligibility Task screen 147
NPI 25

providers 43
NPI considerations 25
NPI number 24, 27

practice level 36
numeric chart numbers only 79

O
Office Hours

Program Options 158
Office Hours Overview 149
Office Hours setup 149
Open Item accounting 190
opening a practice 22
Options and Codes tab 50
overview

reports 163
setting up a practice 14

overviews
setup 22



 Index

CGM MEDISOFT 27
194 27 December 2022

P
patient flagging 176

color coding 176
Patient Ledger 109
Patient List screen 80
patient records

setting up 79, 97
patient remainder statements 127
Patient screen

Payment Code 80
patient screen

Name, Address tab 80
Other Information tab 80

patients
creating 80
entering 80

Payment Code on Patient screen 80
payments

applying to charges 129
entering 129

Payor Type field 129
permissions 33
Personal tab

cases 88
Physician Signature on File 50
Policy tabs

cases 89
practice

creating 21
opening 22

Practice Pay-To tab 36
practice setup

the right way 22
practices, multiple

creating 22
printing

reports 163
troubleshooting 127

printing claims 115
printing statements 122
procedure codes

Allowed Amounts tab 59
Amounts tab 58
General tab 58

Production Reports 169
program date

changing 22
Program Options

Color-Coding tab 176
General tab 173
Payment Application tab 174

program options
aging reports tab 175
audit tab 178
BillFlash tab 179
billing tab 176
color-coding tab 176
HIPAA tab 175

Provider Class List 43
Provider IDs window 27
providers

entering 41
setting up 41

providers rules 43

Q
Quick Balance 110
Quick Ledger 109
Quick Statement option 110

R
referring physicians

rules creation 26, 28
referring provider records 45
referring providers

records 45
setting up 45

report
searching for detail 164

report procedures 163
reports

available 163
exporting 164
Office Hours 161
overview 163
printing 163
procedures 163
viewing 163

reports menu 7
reports overview 163
reprinting claims 119
reprinting statements 125
restoring a backup 182
restoring a hot backup 182
restoring data 181
Revenue Management 38, 145, 190
rules

creating 23
facilities 53
providers 43



CGM MEDISOFT 27
December 2022 27 195

 Index

S
Save Report to Disk option 163
screens

Billing Code List 75
Case 88
Claim Management 114
Collection List 143
Contact 77
Contact List 77
Create Claims 114
Data Selection Questions 163
Deposit (new) 129
Medisoft Task Scheduler 147
New Eligibility Task 147
Patient List 80
Small Balance Write-off 143
Transaction Entry 107
Unprocessed Charges 108

searching for specific detail in a report 164
security 31

setting up 31
security supervisor

role 34
Send Facility on Claim check box 26, 28
Send Ordering Provider in Loop 2420E box 51
Send Practice Taxonomy in Loop 2000A box 51
setting permissions 33
setting Program Options 28
setting up

appointments 150
case records for Office Hours 150
eligibility verification 145
patient records for Office Hours 150
provider records for Office Hours 150
referring providers 45
resource records for Office Hours 150

setting up a case 87
setting up a practice

overview 14
setting up insurance carriers and nsurance 

classes 49
setting up Office Hours 149
setting up patient records 79, 97
setting up providers 41
setting up security 31
setting up your practice

order of activities 22
setup overview 22
Shortcut Bar 3
Signature Date field

providers 42

Signature on File box 42
Small Balance Write-off screen 143
small balance write-offs 143
Social Security number 24, 80
solo provider 24
statement

changing status 125
troubleshooting 127

statement billing notes
setting up 177

statement billling notes
activating 177

statement management 121
Statement Pay To tab 37
statement processing 145

BillFlash 145
statements

creating 121
editing 122
printing 122
reprinting 125

status
changing claims 119
changing statement 125

Stmt Submission Count + field 143
superbill 190
Suppress UB04 Fields check box 174

T
tabs

Appointment Display 160
task scheduling

eligibility verification 147
tax ID 24
taxonomy 24
Taxonomy number 190
taxonomy number 23
Title Bar 1
Toolbar 1
toolbar

customizing 2
tools menu 8
Transaction Entry screen 107
transactions

entering 107
troubleshooting insurance claims 117
troubleshooting statement printing 127

U
UB04 fields 174
Unique Physician Identification Number (UPIN)



 Index

CGM MEDISOFT 27
196 27 December 2022

UPIN 190
Unprocessed Charges screen 108
unprocessed transactions 108
Use numeric chart numbers check box 79
user access levels 33
users

creating 31

V
viewing

reports 163

W
Warn on Unapproved Codes check box 176
window menu 8


	Title page
	Table of Contents
	Preface
	Where to Find Help
	Online Help
	Training
	Independent Value-Added Resellers

	CGM MEDISOFT Versions

	Chapter 1 - Navigating in CGM MEDISOFT
	Toolbars
	Title Bar
	Menu Bar
	Toolbar
	Shortcut Bar

	Menus
	File Menu
	Edit Menu
	Activities Menu
	Lists Menu
	Reports Menu
	Tools Menu
	Window Menu
	Help Menu

	Keystrokes and Shortcuts
	Common Keystrokes
	Keystrokes - List screens
	Keystrokes - Transaction Entry
	Keystrokes - Eligibility


	Chapter 2 - CGM MEDISOFT at a Glance
	Setting up Your Practice Overview
	Entering Transactions and Payments
	Generating Claims and Statements

	Chapter 3 - Creating a Practice and Setup Overview
	Creating a Practice
	Creating the Practice Database
	Opening a Practice

	Setup Overview
	Creating Rules Overview
	If you are a solo provider (file claims as an individual)
	If you are a group (file claims as a group)

	Setting Program Options

	Chapter 4 - Security Setup Overview
	Users upgrading
	Creating Users
	Login/Password Management
	Setting Permissions

	Chapter 5 - Entering Practice Information
	Entering Basic Practice Information
	Entering a Practice IDs Rule
	Entering Practice Information for a Billing Service
	Billing Services
	BillFlash Users

	EDI Receiver Records

	Chapter 6 - Setting up Providers and Provider Classes
	Entering Provider Information
	Entering Provider IDs Rules


	Chapter 7 - Referring Provider Records
	Entering Referring Provider Information
	Entering Referring Provider Rules

	Chapter 8 - Insurance Classes and Insurance Carriers
	Insurance Classes
	Insurance Carriers

	Chapter 9 - Facility Information
	Setup Scenarios
	Entering Facility Information
	Entering Facility IDs Rules

	Chapter 10 - Attorney, Employer, or Other Addresses
	Chapter 11 - Procedure, Payment, Adjustment, and Diagnosis Codes
	Procedure, Payment, and Adjustment Codes
	General Tab
	Amounts Tab
	Allowed Amounts Tab (Advanced and CGM MEDISOFT Network Professional)

	MultiLink Codes
	CPT Code Search
	New CPT Code Search screen (single code search)
	New CPT Code Search screen (multiple code search)


	Chapter 12 - Diagnosis Codes
	IMO - Enhanced ICD Search

	Chapter 13 - Billing Code List
	Chapter 14 - Contact List
	Chapter 15 - Patients
	Chart Number Considerations
	Entering Patient Information
	Patient Alerts


	Chapter 16 - Cases
	Creating a Case
	Copying a Case
	Customizing the Case screen
	Scanning


	Chapter 17 - Transaction Entry Alerts
	Transaction Entry Alerts screen
	Transaction Entry Alert pop-up

	Chapter 18 - Entering Transactions
	Unprocessed Transactions

	Chapter 19 - Quick Ledger and Quick Balance
	Quick Ledger
	Quick Balance

	Chapter 20 - Creating Claims
	Claim Management
	The Claim Manager’s Job
	Creating Claims
	Editing Claims
	Printing Claims

	Troubleshooting Insurance Claims
	Claim Form Not Centered
	Reprinting Claims
	Changing Claim Status


	Chapter 21 - Creating Statements
	Statement Management
	Creating Statements
	Editing Statements
	Printing Statements
	Reprinting Statements
	Changing Statement Status
	Billing Cycles

	Troubleshooting Statement Printing

	Chapter 22 - Applying Deposits/Payments
	Entering a Payment
	Applying a Payment

	EOB Payments
	Managed Care
	Capitation Payment

	ePayments

	Chapter 23 - AR Tracker
	Chapter 24 - Managing Small Balance Write-Offs
	Small Balance Write-off

	Chapter 25 - Using Electronic Services
	Electronic Claims Processing
	Statement Processing
	Eligibility Verification
	Eligibility Verification Setup
	Eligibility Verification Results


	Chapter 26 - Scheduling Appointments
	Office Hours Overview
	Starting the Program
	Office Hours Setup
	Using Office Hours
	Entering a New Appointment
	Find Open Time
	Go To Date
	Wait List

	Editing an Appointment
	Changing a Telephone Number or Cell Phone
	Changing Other Information

	Viewing Scheduled Appointments
	Viewing Future Appointments
	Using the Future Appointment List screen
	Using the Edit Appointment screen

	Rescheduling an Appointment
	Moving/Deleting an Appointment
	Moving an Appointment
	Deleting an Appointment

	Recalling Patients
	Setting Program Options
	Options tab
	Multi Views tab
	Appointment Display tab


	Chapter 27 - Reports
	Reports Overview
	Report Procedures
	Viewing a Report
	Printing a Report
	Exporting a Report
	Searching for a Specific Detail in a Report

	Available Reports
	Day Sheets
	Analysis Reports
	Aging Reports
	Production Reports
	Activity Reports
	Collection Reports
	Audit Reports


	Chapter 28 - Program Options
	General Tab
	Data Entry Tab
	Payment Application Tab
	Aging Reports Tab
	HIPAA Tab/ICD 10
	Color-Coding Tab
	Transactions
	Patients

	Billing Tab
	Statements
	Billing Notes

	Audit Tab
	BillFlash Tab

	Chapter 29 - Backup and Restore Data
	Backing Up Your Data
	Restoring Your Data
	Making a Hot Backup
	Restoring Your Hot Backup

	Chapter 30 - Merge Patients
	Glossary
	Index

